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Présentation d’AutoCAD

L’interface graphique

Présentation de l’écran

K

O

J

A

D

C

E F G H

I

B

NL
M

A. Barre de titre et Menus déroulants 
La barre de titre indique le nom et l’emplacement du dessin actif. Les menus déroulants permettent 
d’accéder à la quasi-totalité des fonctions du logiciel.

B. Barre d’outils Standard

C. Barre d’outils Styles 
Permet la gestion des styles de texte, de cote, et de tableaux.

D. Barre d’outils Calques 
Permet la gestion des calques du dessin.

E, F, G, H. Barre d’outils Propriétés 
Permet de choisir la couleur, le type de ligne, l’épaisseur et le style de tracé des objets dessinés.

I, J. Barres d’outils Dessin et Modification
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K. Réticule (curseur dans la zone graphique)

L. Icône du Système de Coordonnées 
Indique l’orientation des axes du système de coordonnées courant.

M. Onglet Objet et Onglets de Présentations 
Permettent de basculer entre l’espace de dessin et l’espace de mise en plan.

N. Fenêtre de Commande 
Permet de taper des commandes, lire l’avancement d’une commande, utiliser les options des 
commandes… Pour afficher la Fenêtre de Texte complète, appuyez sur la touche F2.

O. Barre d’Etat 
Contient une zone d’affichage des coordonnées du curseur, des boutons d’activation pour les fonctions 
d’aide au dessin, ainsi que les icônes de notification.

Utilisation des barres d’outils

Cliquez simplement sur une icône pour utiliser un outil. 
Il suffit d’immobiliser une seconde le pointeur au-dessus d’une icône pour afficher une infobulle indiquant le nom de 
la commande. Une description plus précise est affichée simultanément dans la barre d’état.

Certaines icônes sont dotés dans le coin inférieur droit d’un triangle noir, indiquant que l’icône est une icône 
déroulante. Maintenez la pression sur l’icône pour afficher la barre d’outils masquée, et relâchez la pression sur 
l’icône de la commande à utiliser.

Gestion des barres d’outils

Les barres d’outils peuvent être ancrées sur un bord de l’écran, ou flottantes dans la zone graphique. Vous pouvez 
les déplacer à votre guise en les tirant par leur barre de titre (pour les barres flottantes), ou par les barres de saisie  
(pour les barres ancrées).

Pour afficher ou masquer des barres d’outils, utilisez le clic droit sur n’importe quelle icône et choisissez une barre 
d’outils dans la liste qui s’affiche.
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 AutoCAD 2006 permet également, à partir de ce même menu, de verrouiller en position les barres et palettes 
d’outils.

 

Masquer les barres d’outils

Affichage > Masquer barres d’outils (CTRL+0)

Permet de masquer ou de réafficher rapidement toutes les barres d’outils, pour disposer d’un espace de travail plus 
grand.

Aspect du curseur

Selon le contexte, le curseur (réticule) aura dans la zone graphique l’un des aspects suivants :

 :	 indique qu’aucune commande n’est active. 

 :	 indique qu’une commande est active, et qu’AutoCAD attend la saisie d’un point, ou l’entrée de 
coordonnées ou d’une distance. 

 :	 indique qu’une commande est active, et qu’AutoCAD attend une sélection d’objet(s).

La ligne de commande

Lorsque vous lancez une commande, AutoCAD affiche dans la ligne de commande des messages pour vous indiquer la 
marche à suivre. Par exemple, pour la commande Raccord :

Paramètres courants: Mode = AJUSTER, Rayon = 0.0000 
Sélectionnez le premier objet ou [Polyligne/Rayon/Ajuster/mUltiple]:

AutoCAD vous indique ici le rayon courant, et vous demande de sélectionner les objets à raccorder. Le rayon courant 
sera utilisé. 
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Mais la commande comporte également un certain nombre d’options, indiquées entre crochets []. L’option Rayon, 
par exemple, permettrait de changer le rayon courant avant de sélectionner les objets à raccorder. 
Chacune des options comporte une ou plusieurs lettres en majuscules. Pour utiliser une de ces options, il faut taper 
dans la ligne de commande la (les) lettre(s) en question, puis valider avec ENTREE.

Exemple :

Paramètres courants: Mode = AJUSTER, Rayon = 0.0000 
Sélectionnez le premier objet ou [Polyligne/Rayon/Ajuster/mUltiple]: r 
Spécifiez le rayon du raccord <0.0000>: 5 
Sélectionnez le premier objet ou [Polyligne/Rayon/Ajuster/mUltiple]:

 Lorsqu’une commande est active, vous pouvez également faire un clic droit dans la zone graphique pour afficher 
le menu contextuel. Les options de la commande y seront disponibles.

Saisie dynamique

Dans AutoCAD 2006, la nouvelle fonction de saisie dynamique permet de se libérer de la ligne de commande. 
En effet, cette fonction permet d’afficher directement à côté du curseur les informations importantes de la ligne de 
commande. Si la commande comporte des options, utilisez la touche flèche descendante du clavier pour y accéder.

La saisie dynamique permet de la même manière de faciliter l’entrée de distances ou coordonnées. Les coordonnées 
entrées sont relatives par défaut. Utilisez la touche TAB pour basculer d’un champ à l’autre.

Le bouton DYN de la barre d’état (ou touche F12) permet d’activer / désactiver la saisie dynamique. Un clic droit sur 
le bouton DYN permet d’accéder aux paramètres de la fonction.
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Gestion des fichiers

Les gabarits

Principe

Un gabarit est un fichier contenant des paramètres prédéfinis (calques, styles, cadre et cartouche, présentations, etc), 
à partir duquel vous pouvez créer de nouveaux dessins. 
Cela évite de devoir redéfinir tous ces paramètres à chaque nouveau dessin. 
L’extension des fichiers gabarits est .DWT.

 Pour créer un dessin basé sur un gabarit, utilisez la commande Nouveau, et non Ouvrir ! Un nouveau fichier dessin 
(DWG) sera alors créé à partir du gabarit (DWT) en récupérant ses paramètres. Vous pourrez ensuite enregistrer le 
nouveau dessin à l’emplacement désiré.

Créer un gabarit

Pour créer un gabarit, il suffit de créer un nouveau dessin, et d’y définir tout ou partie des paramètres suivants : 
• unités, limites du dessin, paramètres de grille et de résolution 
• calques 
• styles de texte, de cotes 
• onglets de présentation avec leurs cadres, cartouches et configurations de tracé 
• toutes variables dépendant du dessin (ATTDIA, etc.).

Le fichier sera ensuite enregistré en tant que gabarit en changeant le type de fichier dans la boîte de dialogue Fichier > 
Enregistrer sous. 

 L’emplacement du répertoire dans lequel sont stockés les gabarits (Template par défaut), peut être modifié dans 
les options d’AutoCAD (Outils > Options > onglet Fichiers > Paramètres du gabarit).

Créer un nouveau document

Par le menu Fichier

Utilisez la commande Fichier > Nouveau (CTRL+N) pour créer un nouveau dessin. Vous pourrez alors choisir de créer 
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un nouveau dessin basé sur un gabarit, un brouillon, ou à l’aide d’un assistant. 
Selon le paramétrage de la variable STARTUP, vous verrez apparaître la boîte de dialogue Sélectionner un gabarit 
(STARTUP = 0), ou la boîte de dialogue Créer un nouveau dessin (STARTUP = 1).

 

Par l’icône Nouveau

Cliquez sur l’icône Rapnouv . Si aucun gabarit par défaut n’est défini, tout se passe de la même manière que lors 
de l’utilisation de la commande Fichier > Nouveau (voir ci-dessus).

Si par contre un gabarit par défaut est défini, un nouveau dessin basé sur ce gabarit sera alors immédiatement créé, 
sans passer par une boîte de dialogue. 
Le gabarit par défaut est défini dans les options d’AutoCAD (Outils > Options > onglet Fichiers).

La variable STARTUP

Cette variable système détermine quelle boîte de dialogue est affichée lors de la création d’un nouveau dessin, ainsi 
qu’au démarrage d’AutoCAD. Elle peut être modifiée en tapant STARTUP dans la ligne de commande, ou dans les 
options d’AutoCAD (Outils > Options > onglet Système).
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La variable FILEDIA

Cette variable permet d’activer/désactiver l’affichage des boîtes de dialogue concernant la gestion des fichiers. 
Si aucune boîte de dialogue n’est affichée lors de la création d’un nouveau dessin, et si AutoCAD vous demande 
dans la ligne de commande d’indiquer le chemin du gabarit à utiliser, tapez FILEDIA dans la ligne de commande, et 
affectez-lui la valeur 1.

Ouvrir un dessin

Ouverture normale

Fichier > Ouvrir (CTRL+O), ou 

La boîte de dialogue Sélectionner un fichier apparaît, permettant de rechercher et d’ouvrir un ou plusieurs dessins 
existants (fichiers DWG, DXF, DWT, DWS).

Ouverture partielle

Sur des dessins de grande taille, vous pouvez utiliser l’option Ouverture partielle, afin de pouvoir sélectionner 
précisément la géométrie à charger, plutôt que d’ouvrir le dessin dans son intégralité.

Dans la boîte de dialogue, sélectionnez le(s) calque(s) à charger, et/ou une vue nommée (s’il en existe dans le dessin).
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Si vous souhaitez importer d’autres portions du dessin en cours de travail, utilisez la commande Fichier > Chargement 
partiel.

Il est évidemment possible d’enregistrer votre dessin partiellement ouvert. A la prochaine ouverture du dessin, 
une boîte de dialogue vous permettra alors de choisir si le dessin doit être ouvert dans l’état dans lequel il aura été 
sauvegardé, ou s’il faut l’ouvrir entièrement.

  La commande PURGER ne peut pas être utilisée dans un dessin partiellement ouvert. 
L’ouverture et le chargement partiels sont impossibles sur un fichier DXF.

Enregistrer un dessin

Enregistrer

Fichier > Enregistrer (CTRL+S), ou 

Enregistre les modifications apportées au fichier, en conservant son nom et son emplacement actuels. Si ceux-ci ne 
sont pas définis (nouveau dessin), la boîte de dialogue Enregistrer sous s’affiche (voir ci-dessous).

Enregistrer sous

Fichier > Enregistrer sous (MAJ+CTRL+S)

Permet d’enregistrer le dessin courant sous un autre nom, à un autre emplacement, et/ou sous un format différent.
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Exporter

Fichier > Exporter

La commande Exporter affiche une boîte de dialogue similaire à la précédente, mais permet d’exporter un dessin sous 
d’autres formats que les formats natifs d’AutoCAD  : WMF, SAT, EPS, etc.

Options d’enregistrement et de sécurité

L’onglet Ouvrir et Enregistrer de la boîte de dialogue Options permet de paramétrer les options d’enregistrement et 
de sécurité des fichiers.
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Format par défaut

Vous pouvez choisir quel sera le format de fichier par défaut lors de l’enregistrement. Cela peut se révéler utile si 
plusieurs versions d’AutoCAD cohabitent au sein d’une même société, par exemple.

Sauvegardes incrémentielles

Définit le pourcentage d’espace inutilisé potentiel dans un fichier de dessin. Lorsque le pourcentage indiqué est 
atteint, AutoCAD effectue un enregistrement complet (plus long) au lieu d’un enregistrement incrémentiel. 
Les enregistrements complets éliminent l’espace inutilisé. Si vous affectez la valeur 0 à l’option Pourcentage 
d’enregistrement incrémentiel, chaque enregistrement est alors complet.

Sauvegardes automatiques

Vous pouvez activer les sauvegardes automatiques et définir leur fréquence. 

 Dans AutoCAD, la sauvegarde automatique n’a aucun effet sur le fichier ouvert (DWG) ! La sauvegarde se fait 
dans une copie temporaire du fichier, qui n’est conservée qu’en cas de fermeture anormale du dessin. Il est à votre 
charge d’enregistrer régulièrement vos dessins en cours de travail.

L’emplacement des fichiers de sauvegarde automatique est définie dans l’onglet Fichiers de la boîte de dialogue 
Options. Ces fichiers ont une extension .SV$. Pour pouvoir les ouvrir, il faut changer leur extension en .DWG via 
l’Explorateur Windows.

Copie de sauvegardes à l’enregistrement

Si cette case est cochée, une copie du fichier correspondant à la version précédente est créée lorsque vous enregistrez 
manuellement votre dessin. Ce fichier se trouve au même endroit que le fichier d’origine, et porte le même nom. 
Seule l’extension est changée en .BAK. 
Changez l’extension en .DWG pour pouvoir ouvrir le fichier dans AutoCAD.

Options de sécurité

Vous pouvez protéger un dessin soit par un mot de passe, qui sera nécessaire pour pouvoir ouvrir le dessin, soit en le 
signant numériquement (nécessite d’avoir fait l’acquisition d’une signature numérique). 
Ces options peuvent également être définies dans le menu Outils de la boîte de dialogue Enregistrer sous.
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Gestion de l’affichage

Environnement multidocument

Naviguer dans les dessins ouverts

AutoCAD permet l’ouverture simultanée de plusieurs dessins. Le menu Fenêtre présente une liste des fichiers ouverts, 
parmi lesquels vous pouvez naviguer. Vous pouvez également utiliser le raccourci CTRL+TAB.

Gestion des fenêtres

Le menu Fenêtre permet également de réorganiser les dessins ouverts, pour les afficher côte à côte en mosaïque 
horizontale ou verticale.

Fermer des dessins

Utiliser la commande Fichier > Fermer ou Fenêtre > Fermer pour fermer le dessin actif. La commande Fenêtre > Fermer 
tout permet de fermer tous les fichiers ouverts.

Zoom et gestion de l’affichage

Les commandes de zoom se trouvent dans la barre d’outils Standard. Il existe également une barre d’outils Zoom que 
vous pouvez afficher (existe sous forme déroulante dans la barre Standard).

Utilisation de la souris

Si vous avez une souris à molette, vous pouvez l’utiliser pour les opérations suivantes :

• Zoom avant/arrière : en tournant la molette, vous pouvez zoomer en avant ou en arrière. La zone agrandie est celle 
se trouvant sous le curseur de la souris. La variable ZOOMFACTOR permet de définir la rapidité du zoom (donner 
une valeur entre 3 et 100).

• Panoramique : vous pouvez déplacer la vue en maintenant la molette enfoncée et en bougeant la souris. La variable 
MBUTTONPAN détermine si la molette (ou le bouton du milieu) sert à faire un panoramique (valeur 1) ou affiche le 
menu des accrochages aux objets (valeur 0).
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• Zoom étendu : vous pouvez effectuer un zoom étendu (afficher tout le dessin à l’écran) en double-cliquant sur la 
molette (ou bouton du milieu).

Panoramique

Affichage > Panoramique > Temps réel (P), ou 

Permet de déplacer la vue dans toutes les directions (équivaut à utiliser les barres de défilements). Maintenir le 
bouton gauche enfoncé et déplacer la souris.

Zoom Temps réel

Affichage > Zoom > Temps réel (Z), ou 

Permet de zoomer en avant/arrière. Maintenir le bouton gauche enfoncé et déplacer la souris vers le haut ou vers le 
bas.

Zoom Fenêtre

Affichage > Zoom > Fenêtre (Z), ou 

Permet de faire une fenêtre autour de la zone à agrandir. Cliquez une première fois pour définir le premier coin de la 
fenêtre, puis une deuxième fois pour définir le coin opposé.

Zoom Dynamique

Affichage > Zoom > Dynamique (Z), ou 

Permet d’agrandir ou rétrécir une partie du dessin à l’aide d’une fenêtre mobile (cadre avec un X au centre) se 
déplaçant sur l’ensemble de l’écran, lorsqu’on déplace la souris. Si vous cliquez avec la souris le X au centre se 
transforme en une flèche et la fenêtre peut être agrandie ou diminuée en déplaçant la souris. En appuyant sur le 
deuxième bouton de la souris la partie à l’intérieur de cette fenêtre mobile est soumise à l’effet du Zoom.

Outre cette première fenêtre, trois autres cadres apparaissent à l’écran :

• Un cadre blanc en trait continu : correspond à la feuille de travail définie par les limites du dessin (voir LIMITES). 
• Un cadre avec quatre coins rouges : correspond à l’écran généré par AutoCAD et qui peut être régénéré à grande 
vitesse. 
• Un cadre vert en traits pointillés : correspond à la zone visualisée sur l’écran avant l’appel du zoom dynamique.

Zoom Echelle

Affichage > Zoom > Echelle (Z), ou 
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Permet de modifier la taille de l’affichage en entrant un facteur d’échelle.

Zoom Centre

Affichage > Zoom > Centre (Z), ou 

Permet de spécifier un point qui deviendra le centre de l’écran.

Zoom Objet

Affichage > Zoom > Objet (Z), ou 

Permet de zoomer sur une sélection d’objets.

Zoom Avant / Arrière

Affichage > Zoom > Avant ou Arrière (Z), ou  

Permet de faire un zoom avant/arrière (équivaut à un zoom échelle 2x ou 0.5x).

Zoom Tout

Affichage > Zoom > Tout (Z), ou 

Permet d’afficher la zone définie par les limites du dessin. 
Si le dessin dépasse les limites, alors le résultat est équivalent au zoom étendu.

Zoom Etendu

Affichage > Zoom > Etendu (Z), ou 

Permet d’afficher tout le dessin à l’écran.

Zoom Précédent

Affichage > Zoom > Précédent (Z), ou 

Permet de revenir en arrière dans l’historique des vues affichées à l’écran. Vous pouvez restaurer jusqu’à 10 vues 
antérieures.
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Vue Aérienne

Affichage > Vue aérienne

Permet d’afficher une partie du dessin sur l’écran tandis que l’ensemble du dessin apparaît dans la vue aérienne. 
Cliquez dans la vue aérienne pour alternativement déplacer ou redimensionner le cadre de vue. Utilisez le clic droit 
pour fixer la position du cadre. 

A

B

A. Fenêtre de la Vue aérienne, affichant l’ensemble du dessin.

B. Cadre de vue, délimitant la partie du dessin affichée dans la zone graphique.

Vues existantes

Affichage > Vues existantes, ou  (barre d’outils Vue)

Cette commande permet d’enregistrer des vues en leur donnant un nom. Ces vues pourront être ensuite restaurées 
facilement avec la même commande. 
Lorsque vous enregistrez une vue, vous pouvez lui associer des informations sur le système de coordonnée actif et 
l’état des calques (AutoCAD 2005). Le système de coordonnées et l’état des calques seront alors restaurés avec la vue.

Une vue nommée peut également être imprimée facilement à l’aide de l’option Vue de la boîte de dialogue 
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Configuration de tracé ou Imprimer. 
Un dessin peut être ouvert directement sur une vue existante, avec l’option Sélectionner la vue initiale dans la boîte 
de dialogue Ouvrir.

Régénérer / Régénérer tout

Affichage > Régénérer (RG) ou Régénérer tout (RGT)

La régénération permet de recalculer l’affichage de tous les objets du dessin dans la fenêtre ou l’espace courant. 
Utilisez cette commande pour faire disparaître les facettes qui apparaissent sur les objets courbes après un zoom, ou 
lorsque le zoom temps réel (ou à la molette) bloque. 
La commande Régénérer Tout régénère toutes les fenêtres dans l’espace Papier.

Multi-fenêtrage

Principe

Le multi-fenêtrage permet de diviser la zone d’affichage graphique en plusieurs fenêtres en mosaïque. Chacune de ces 
fenêtres pourra alors afficher une vue différente du dessin. 
Il s’agit d’une option très intéressante dans des dessins complexes, ou en 3D.

Fenêtres

Affichage > Fenêtres, ou  (barre d’outils Fenêtres)

Permet de diviser la zone d’affichage graphique en plusieurs fenêtres en mosaïque, chacune affichant tout ou une 
partie du dessin. 
Chacune des fenêtres peut avoir son facteur de zoom, son propre SCU, afficher ou non la grille, utiliser un mode 
d’ombrage différent, etc.
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Paramètres du dessin

Unités et Limites

Principes du dessin dans AutoCAD

AutoCAD utilise deux espaces distincts pour la création et la mise en page d’un dessin :

• l’onglet Objet, dans lequel sera créé le dessin 
• l’espace Papier (sous la forme d’un ou plusieurs onglets de Présentation), dans lequel sera créée la mise en page de 
notre dessin (ce chapitre sera traité plus tard).

AutoCAD n’utilise pas un système prédéfini d’unités de mesure, telles que les mètres ou les pouces, mais un système 
d’unités absolues. 
Il vous suffit donc, avant de commencer à dessiner, de choisir la correspondance entre une unité AutoCAD et les 
unités du monde réel (ex : 1 unité = 1 mm réel). 
Quelle que soit l’unité choisie, vous devrez toujours dessiner vos objets à leurs dimensions réelles. Ceci ne posera 
jamais aucun problème, étant donné que la surface de travail d’AutoCAD est infinie. La mise à l’échelle sera réalisée 
par la suite dans un onglet de Présentation.

Contrôle des unités

Format > Contrôle des unités

Vous pouvez définir le format et la précision d’affichage de l’unité de longueur, ainsi que l’unité et la précision des 
mesures angulaires. Ces informations servent principalement à déterminer sous quelle forme les dimensions doivent 
être entrées dans la ligne de commande, ainsi qu’à déterminer la précision des mesures obtenues à l’aide des outils de 
renseignement (Outils > Renseignements).

A

B

C
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A. Si elle est cochée, cette case définit le sens horaire comme sens positif pour les angles, plutôt que le 
sens trigonométrique (antihoraire).

B. Indiquez ici quelle est l’unité de dessin utilisée, afin qu’AutoCAD puisse redimensionner correctement 
les blocs insérés à l’aide du Design Center.

C. Ce bouton permet de choisi la direction de l’angle 0 (le Nord par défaut, soit l’axe Y positif).

Les Limites du dessin

Format > Limites du dessin

Les limites du dessin correspondent à une zone rectangulaire du dessin, et déterminent les dimensions de la grille 
lorsque celle-ci est affichée.

Commande: limites 
Restaurer les limites de l’Espace objet: 
Spécifiez le coin inférieur gauche ou [ACtif/INactif] <0.0000,0.0000>: 
Spécifiez le coin supérieur droit <420.0000,297.0000>: 210,297

Tapez à l’invite de commande les coordonnées des coins inférieur gauche et supérieur droit (ou cliquez les points) 
pour redéfinir les limites. 
Les limites sont inactives par défaut, ce qui signifie que vous pouvez dessiner où bon vous semble. Si vous utilisez 
l’option ACtif, vous ne pourrez plus dessiner qu’à l’intérieur des limites du dessin.

Distances et coordonnées

Lorsque vous devez indiquer la position d’un point dans AutoCAD, plusieurs possibilités s’offrent à vous :

• cliquer un point 
• entrer directement sa distance par rapport au point précédent, en indiquant une direction à la souris 
• entrer des coordonnées.

Entrée de distances

Il est possible de placer un point par rapport au point précédent en tapant une distance dans la ligne de commande, 
tout en indiquant la direction à la souris. 
Cette méthode est intéressante en combinaison avec le mode Ortho, le repérage polaire, ou le repérage d’accrochage 
aux objets (voir Aides au dessin).

Entrée de coordonnées cartésiennes absolues

Tous les points définis dans AutoCAD sont positionnés dans un Système de Coordonnées Général, de type cartésien, 
doté d’un axe X horizontal, d’un axe X vertical, et d’un axe Z perpendiculaire à l’écran (nous verrons plus loin qu’il 
est en fait possible de changer de système de coordonnées à n’importe quel moment). 
Chaque point a donc des coordonnées absolues X, Y et Z uniques, définissant sa position par rapport à l’origine du 
SCG (qui a pour coordonnées 0,0,0). 
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Vous pouvez taper des coordonnées absolues sous la forme X,Y(,Z) pour positionner des points dans votre dessin.

Exemple :

Commande: _line Spécifiez le premier point: 3,2 
Spécifiez le point suivant ou [annUler]: 8,7

Entrée de coordonnées cartésiennes relatives

Vous pouvez positionner un point par rapport au point précédent, en entrant des coordonnées relatives sous la forme 
@∆X,∆Y(,∆Z). Les valeurs ∆X et ∆Y correspondent aux valeurs de déplacement selon les axes X et Y par rapport au 
point précédent.

Exemple :

Commande: _line Spécifiez le premier point:(point A cliqué) 
Spécifiez le point suivant ou [annUler]: @5,-4
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Entrée de coordonnées polaires

Plutôt que de positionner un point à l’aide de coordonnées cartésiennes, il peut être intéressant de le positionner à 
l’aide d’une distance et d’un angle. 
Dans le cas de  coordonnées polaires absolues, la distance L est mesurée depuis le point d’origine du SCG. La notation 
est L<a. 
Dans le cas de coordonnées polaires relatives, la distance L est mesurée depuis le dernier point entré. La notation est 
@ L<a. 
Dans les deux cas, l’angle a est l’angle absolu (angle par rapport à l’angle 0).

Exemple :

Commande: _line Spécifiez le premier point:(point A cliqué) 
Spécifiez le point suivant ou [annUler]: @5<-30

Aides au dessin

La Grille

Outils > Aides au dessin > onglet Grille/Résolution

La grille est un ensemble de points régulièrement espacés, qui s’étendent sur la zone définie par les limites du dessin. 
La grille, lorsqu’elle est visible, joue le rôle d’une feuille de papier quadrillé. et vous aide à aligner les objets et à 
visualiser les distances qui les séparent. La grille n’est pas tracée sur papier. 

La grille s’active ou se désactive à l’aide du bouton  de la barre d’état (ou F7). 
L’espacement des points de la grille peut être modifié en faisant clic droit > Paramètres sur ce même bouton.
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La Résolution

Outils > Aides au dessin > onglet Grille/Résolution

La résolution permet de limiter le déplacement du pointeur dans la zone graphique, en le forçant à s’aimanter sur une 
grille invisible. Cette grille peut être rectangulaire, isométrique ou polaire. 

La résolution est activée ou désactivée à l’aide du bouton  de la barre d’état (ou F9). 
Son pas peut être modifié en faisant clic droit > Paramètres sur ce même bouton.

 

Le Mode Ortho

 (F8)

En mode Ortho, le curseur ne peut se déplacer que parallèlement aux axes X et Y dus système de coordonnées 
courant. Cela permet par exemple de dessiner facilement une série de lignes perpendiculaires.
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Le Repérage polaire

Outils > Aides au dessin > onglet Repérage polaire

Le repérage polaire permet, comme le mode Ortho, de contraindre la direction du curseur, mais selon un angle 
d’incrémentation que vous pouvez définir. 
Un vecteur de direction s’affiche lorsque la direction du curseur correspond à un multiple de l’angle d’incrémentation 
(ou à un angle supplémentaire). L’angle est défini par rapport au système de coordonnées courant, ou par rapport au 
dernier segment tracé, suivant l’option de mesure d’angle polaire.

Le repérage polaire est activé ou désactivé à l’aide du bouton  de la barre d’état (ou F10). 
Ses paramètres peuvent être modifiés en faisant clic droit > Paramètres sur ce même bouton.

   

Accrochages aux objets permanents

Outils > Aides au dessin > onglet Accrochage aux objets

Les accrochages aux objets permettent de détecter et de s’accrocher facilement sur des points particuliers de la 
géométrie (extrémités, centres, intersections, etc.) en dessinant. 

L’accrochage aux objets est activé ou désactivé à l’aide du bouton  de la barre d’état (ou F4). 
Les paramètres d’accrochage peuvent être modifiés en faisant clic droit > Paramètres  sur ce même bouton. 
Les points d’accrochage cochés dans cette boîte de dialogue seront détectés automatiquement au cours du dessin, et 
signalés par un marqueur AutoSnap et une infobulle. Il suffit alors de cliquer pour s’accrocher sur le point.

 Vous pouvez appuyer plusieurs fois sur la touche TAB pour afficher tour à tour tous les accrochages disponibles 
pour l’objet sur lequel se trouve le curseur.
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Accrochage ponctuel

Vous pouvez également activer ponctuellement un accrochage particulier en dessinant. Cet accrochage sera alors le 
seul actif, jusqu’à ce que le point soit cliqué. Les paramètres d’accrochage précédents seront ensuite restaurés.

Pour activer ponctuellement un accrochage alors qu’une commande de dessin est active, vous pouvez :

• cliquer sur une icône de la barre d’outils Accrochage aux objets, si vous l’avez affichée 
• faire CTRL + clic droit (ou bouton du milieu si MBUTTONPAN = 0) pour afficher le menu des accrochages 
• faire clic droit > Remplacer accrochage (AutoCAD 2005).

Point de repérage temporaire (TT) : permet d’activer ponctuellement le repérage 
(alignement) par rapport au point cliqué
Depuis : permet de choisir un point de référence pour des coordonnées relatives

EXTrémité : accroche l’extrémité la plus proche (lignes, arcs, polylignes)

MILieu : accroche le milieu d’un objet (lignes, arcs, polylignes)

INTersection : accroche l’intersection de deux objets

INTersection : accroche l’intersection de deux objets

EXTension : permet de s’accrocher dans le prolongement d’un objet

CENtre : accroche le centre d’un cercle, d’un arc, ou d’une ellipse

QUAdrant : accroche les quadrants d’un cercle, d’un arc, ou d’une ellipse

TANgente : permet de tracer une tangente d’un point à un cercle, arc, ellipse

PERpendiculaire : permet de tracer une perpendiculaire depuis point sur un objet

PARallèle : permet de tracer une parallèle par rapport à une référence

INSertion : permet de tracer une parallèle par rapport à une référence

NODal : permet de s’accrocher sur un objet de type Point

PROche : permet de s’accrocher n’importe où sur un objet

AUCun : désactive temporairement tous les accrochages

Affiche les paramètres d’accrochage

La version 2005 ajoute un accrochage Milieu de deux points (M2P), accessibles dans le menu des accrochages.
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Repérage d’accrochages aux objets

Le repérage permet tout en dessinant de s’aligner facilement sur des points d’accrochage. Les possibilités offertes par 
cette fonction dépendent donc des accrochages actifs. 
Pour vous aligner sur un point, positionnez le curseur sur un point d’accrochage (sans cliquer), jusqu’à ce que le 
point de repérage soit acquis. Bougez ensuite la souris pour voir apparaître un vecteur d’alignement en pointillé. 
Vous pouvez acquérir simultanément jusqu’à 7 points de repérage. Placez le curseur sur un point de repérage pour le 
désactiver. 
Par défaut, le repérage ne permet de s’aligner qu’horizontalement ou verticalement. Vous pouvez néanmoins utiliser 
le repérage en combinaison avec tous les angles définis dans les paramètres de l’accrochage polaire (voir paramètres de 
l’accrochage polaire).

Le repérage d’accrochage aux objets est activé ou désactivé à l’aide du bouton  de la barre d’état (ou F11).

Options d’accrochage et de repérage

Outils > Options > onglet Dessin (OP)

Cet onglet permet de personnaliser les paramètres de l’accrochage aux objets, du repérage polaire, et du repérage 
d’accrochage aux objets.
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Dessin

Outils de dessin

Les outils de dessin d’AutoCAD se trouvent dans le menu Dessin, ou la barre d’outils Dessin.

Ligne

Dessin > Ligne (L), ou 

Permet de dessiner une série de segments consécutifs. Chaque segment peut être modifié séparément.

Options :

annUler : 	 permet d’annuler le dernier segment sans quitter la commande 
Clore : 	 trace un segment revenant au point de départ du premier segment, pour former un contour fermé.

Droite, demi-droite

Dessin > Demi-droite ou Droite, ou 

Permet de créer une droite (ligne infinie) passant par deux points. La demi-droite est infinie dans une direction 
seulement.

Options :

Hor, Ver : 	 crée une droit horizontale ou verticale passant par un point 
Ang : 	 crée une droite avec un angle donné passant par un point, ou par rapport à un objet (option 
Référence) 
Bissect : 	 crée une droite partageant l’angle défini par 3 points en deux angles égaux 
Décalage : 	 crée une droite parallèle à un objet à une distance donnée, ou passant par un point (option Par).

Multiligne

Dessin > Multiligne

Permet de dessiner jusqu’à 16 lignes parallèles simultanément, chacune pouvant avoir une couleur et un type de ligne 
différent. 
Il faudra au préalable créer un style de multiligne (Format > Style de multiligne). 
Les multilignes peuvent être éditées avec la commande Modification > Objet > Multiligne.
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Polyligne

Dessin > Polyligne (PO), ou 

Une polyligne est constituée de segments et d’arcs consécutifs, et joints pour former une seule entité ouverte ou 
fermée. La polyligne est le seul type d’objet dans AutoCAD pouvant avoir une épaisseur de trait.

Options :

Arc : 	 en utilisant cette option, le prochain segment de la polyligne sera un arc 
Clore : 	 crée un segment vers le point de départ de la polyligne, afin de créer une polyligne fermée 
Demi-larg : 	 permet d’indiquer la demi-largeur du segment suivant 
LOngueur : 	 dessine un segment de la longueur spécifiée, selon le même angle que le segment précédent 
annUler : 	 supprime le dernier segment ajouté à la polyligne 
LArgeur :	 détermine l’épaisseur du segment suivant.

Commandes d’édition : 
Modification > Objet > Polyligne (PE), ou  (barre d’outils Modification II) 
Cette commande permet de modifier une polyligne existante (largeur, clore, etc.), ou de transformer en polyligne 
une série de lignes et d’arcs consécutifs (option Joindre). 

Modification > Objet > Décomposer (DE), ou  (barre d’outils Modification) 
Permet de décomposer une polyligne en objets simples (lignes et arcs).

Polygone

Dessin > Polygone (PG), ou 

Permet de tracer un polygone régulier de 3 à 1024 côtés. Le polygone est, dans AutoCAD, une polyligne fermée. 
Par défaut, on indique le centre du polygone, et celui-ci est créé d’après un cercle virtuel dont on indique le rayon. 
Le polygone peut être inscrit dans ce cercle (rayon = distance du centre à un sommet), ou être circonscrit à ce cercle 
(rayon = distance du centre au milieu d’un côté).
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Options :

Côté : permet de définir les dimensions du polygone en indiquant deux sommets consécutifs.

Commandes d’édition :

Voir Polyligne

Rectangle

Dessin > Rectangle (RC), ou 

Permet de tracer un rectangle en définissant deux sommets opposés en diagonale. Le rectangle est, dans AutoCAD, 
une polyligne fermée. 
Pour dimensionner le rectangle, vous pouvez positionner le deuxième point par rapport au premier à l’aide de 
coordonnées relatives, ou en utilisant l’option Cotes (AutoCAD 2002).

Options :

Chanfrein : 	 permet de définir les distances de chanfrein des sommets pour les rectangles suivants 
Elévation : 	 spécifie l’élévation en Z à laquelle le rectangle sera dessiné 
Raccord : 	 permet de définir le rayon des raccords pour les rectangles suivants 
Hauteur : 	 détermine la hauteur en Z des côtés du rectangle 
Largeur : 	 détermine l’épaisseur des segments du rectangle 
Cotes : 	 crée un rectangle en utilisant des valeurs pour la longueur et la largeur (AutoCAD 2002) 
Aire :	 permet de créer un rectangle en spécifiant son aire et l’une de ses cotes (AutoCAD 2006) 
Rotation :	 permet de créer un rectangle en spécifiant son angle de rotation (AutoCAD 2006).

Commandes d’édition :

Voir Polyligne

Arc

Dessin > Arc (A), ou 

Permet de dessiner un arc de cercle. L’utilisation du menu Dessin > Arc permet de choisir parmi de nombreuses 
méthodes. Les arcs sont généralement tracés suivant le sens positif des angles.

Cercle

Dessin > Cercle (C), ou 

Permet de dessiner un cercle. L’utilisation du menu Dessin > Cercle permet de choisir parmi de nombreuses méthodes.

Options :

3P : 	 permet de dessiner un cercle en positionnant 3 points de sa circonférence 
2P : 	 permet de dessiner un cercle en positionnant 2 points diamétralement opposés 
Ttr : 	 permet de dessiner un cercle tangent à 2 objets, et d’un rayon donné 
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Diamètre : 	 dimensionne le cercle en fonction de son diamètre.

Nuage

Dessin > Nuage de révision, ou 

Cette commande permet de dessiner un nuage utilisé comme outil pour l’annotation et la révision de dessins. Le 
nuage est une polyligne composée d’arcs.

Options :

Longueur : 	 spécifie la longueur minimum et maximum des arcs du nuage 
Objet : 	 permet de transformer en nuage un objet fermé existant (cercle, rectangle, etc.) 
Style : 	 permet de choisir entre le nuage normal et le nuage calligraphié.

Commandes d’édition :

Voir Polyligne

Spline

Dessin > Spline (SPL), ou 

Permet de créer des courbes de types NURBS (courbes B-spline rationnelles non uniformes) en définissant des points 
de lissage, puis l’angle de tangence aux points de départ et de fin de la courbe. 
Ces courbes peuvent être utiles dans divers domaines (courbes de niveau en topographie, création de surfaces gauches 
en D, etc.).

Options :

OBjet : 	 permet de convertir en spline véritable une polyligne ayant subi un lissage de type Spline à l’aide de la 
commande Editer polyligne. 
Clore : 	 permet de créer une spline fermée 
Tolérance : 	 avec une tolérance de 0, la courbe spline passe par les points de lissage. Plus la tolérance est 
importante, plus la spline pourra	s’éloigner des points de lissage.

Commandes d’édition : 
Modification > Objet > Spline, ou  (barre d’outils Modification II)
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Ellipse

Dessin > Ellipse (EL), ou 

Crée une ellipse ou un arc elliptique. Plusieurs méthodes de création d’ellipse sont disponibles dans le menu Dessin > 
Ellipse.

Options :

Centre : 	 permet de créer une ellipse en positionnant son centre 
Arc : 	 permet de créer un arc elliptique en conservant une portion de l’ellipse.

Points

Dessin > Point (PT), ou 

Permet de créer un ou plusieurs objets de type Point, sur lesquels vous pouvez vous accrocher à l’aide de l’accrochage 
objet Nodal. 
Le style d’affichage des points peut être modifié dans la boîte de dialogue Format > Style de points. Le style de points 
s’applique à tous les points du dessin.

La commande Diviser permet de placer à intervalles réguliers des points sur un objet, afin de le diviser en un certain 
nombre de segments égaux. 
La commande Mesurer permet de placer à intervalles réguliers des points sur un objet, en spécifiant la distance entre 
deux points.

Hachures

Dessin > Hachures (FH), ou 

Vous pouvez remplir une zone avec un motif de hachures, une couleur unie (utiliser le motif SOLID), ou un dégradé 
de deux couleurs (AutoCAD 2004).

 Pour choisir un contour à hachurer à l’aide du bouton Choix des points, il est préférable, pour des questions de 
performance, que le contour soit affiché en entier à l’écran, et le plus grand possible. N’hésitez donc pas à zoomer sur 
le contour avant de créer les hachures.
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A. Permet de choisir le type de motif (prédéfini ou défini par l’utilisateur)

B. Choix du motif. Cliquez sur le témoin pour afficher la palette de motifs.

C. Permet de faire pivoter le motif d’un angle donné (ou de définir l’angle des hachures définies par 
l’utilisateur), ainsi que son échelle. Si la case en-dessous est cochée, l’échelle des hachures sera corrigée en 
fonction de l’échelle de la fenêtre courante (en Présentation uniquement).

D. Permet de définir l’espacement des hachures définies par l’utilisateur. 

E. Permet de définir le point d’origine pour le motif de hachures (AutoCAD 2006).

F. Permet de choisir les zones à hachurer en cliquant à l’intérieur des contours. Les contours doivent être 
fermés.

G. Permet de choisir les zones à hachurer en sélectionnant les objets définissant les contours.

H. Permet de retirer des îlots (contours imbriqués) de la sélection.

I. Permet de recréer un contour associé à un motif de hachure isolé (AutoCAD 2006).

J. Permet de créer des hachures associatives (qui s’adapteront au contour si celui-ci est modifié) ou non.

K. Détermine si un ou plusieurs objet(s) de hachures est(sont) créé(s) lorsque plusieurs contours fermés 
sont spécifiés (AutoCAD 2006).

L. Permet de choisir si les hachures créées doivent être placées au-dessus ou en-dessous des contours.

M. Permet de récupérer les paramètres d’un motif de hachure existant en le sélectionnant.

N. Dans AutoCAD 2006, affiche les options avancées (voir page suivante), équivalent à l’onglet Avancé des 
versions précédentes.
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A. Permet de choisir la manière dont les îlots seront hachurés.

B. Détermine la taille maximum des ouvertures dans un contour. Cela permet de hachurer une zone 
ouverte en cliquant un point, si les ouvertures ne dépassent pas la tolérance définie (AutoCAD 2005).

Commandes d’édition : 

Modification > Objet > Hachures, ou  (barre d’outils Modification II) 
clic clic

 sur le motif (AutoCAD 2002)

Région

Dessin > Région (REG), ou 

Permet de transformer en région un (des) contour(s) fermé(s) constitué(s) de : lignes, arcs, cercles, polylignes, 
ellipses, spline, solides. Ces objets doivent être coplanaires. 
La région pourra ensuite être utilisée dans une opération booléenne (union, soustraction, ou intersection) avec une ou 
plusieurs autres régions, ou être transformée en solide 3D par extrusion ou révolution. 
Vous pouvez également connaître les propriétés mécaniques d’une région (aire, centre de gravité, moments, etc.) à 
l’aide de la commande Outils > Renseignements > Propriétés mécaniques.

Commandes d’édition : 

Modification > Objet > Décomposer (DE), ou  (barre d’outils Modification) 
Permet de décomposer une région en objets simples (lignes et arcs).
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Outils de modification

Les commandes suivantes permettent la manipulation des objets créés avec les outils de dessin. Ces commandes se 
trouvent dans le menu Modification, ou dans la barre d’outils Modification.

D’une manière générale, l’utilisation de ces commandes nécessite de sélectionner un ou plusieurs objets à manipuler.

Options de sélection

Outils > Options > onglet Sélection (OP)

Cet onglet permet de déterminer les options de sélection.

A

B
C
D
E
F
G

A. Permet de régler la taille du curseur carré de sélection.

B. Lorsque la sélection nom/verbe est active, vous pouvez sélectionner des objets avant de lancer une 
commande de modification (variable PICKFIRST).

C. Si cette case est cochée, il vous faudra maintenir la touche MAJ enfoncée pour pouvoir sélectionner 
plusieurs objets en cliquant dessus (variable PICKADD)

D. Permet de tracer des fenêtres de sélection en maintenant le bouton gauche de la souris enfoncé, plutôt 
qu’en cliquant deux points.

E. Permet de tracer automatiquement une fenêtre de sélection en cliquant dans une zone vide du dessin.

F. Si la case est cochée, permet de sélectionner le groupe entier en cliquant sur un membre du groupe.

G. Si la case est cochée, les objets composant le contour hachuré sont sélectionnés en même temps que le 
motif de hachures.

Sélection d’objets

Lorsque vous utilisez une commande de modification, AutoCAD affiche le message suivant dans la ligne de 
commande :
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Choix des objets:

Il vous faut alors sélectionner un ou plusieurs objets du dessin. Plusieurs méthodes s’offrent à vous :

• cliquez sur un ou plusieurs objets successivement : �AutoCAD ajoute les objets au jeu de sélection au fur et à mesure.

• tracez une fenêtre de sélection ou de capture : cliquez dans une zone vide de l’écran pour commencer une fenêtre, 
puis une deuxième fois pour terminer la fenêtre. 
- Si la fenêtre est tracée de la gauche vers la droite, c’est une fenêtre de sélection (en traits continus, couleur bleue 
translucide dans AutoCAD 2006), qui sélectionnera uniquement les objets entièrement inclus dans la fenêtre. 
- Si la fenêtre est tracée de la droite vers la gauche, c’est un fenêtre de capture (en pointillés, couleur verte 
translucide dans AutoCAD 2006), qui sélectionnera également tous les objets inclus partiellement dans la fenêtre 
(touchés par la fenêtre).

 

• entrez une des options de sélection suivantes :

Dernier :	 ajoute le dernier objet créé au jeu de sélection 
Précédent :	 permet de récupérer le jeu de sélection précédent 
Fenêtre :	 force la sélection par fenêtre, quel que soit le sens de tracé de la fenêtre 
Capture :	 force la sélection par capture, quel que soit le sens de tracé de la fenêtre 
BOîte :	 crée une fenêtre de sélection ou de capture, selon le sens de tracé de la fenêtre 
SPolygone :	 crée une fenêtre de sélection polygonale (non rectangulaire) 
CPolygone :	 crée une fenêtre de capture polygonale 
Trajet :	 permet de définir une trajectoire en cliquant plusieurs points. Tous les objets croisés seront 
sélectionnés. 
uniQue :	 sélectionne un seul objet et poursuit le déroulement de la commande 
Groupe :	 entrez le nom d’un groupe d’objets pour le sélectionner 
Supprimer :	 permet de retirer des objets du jeu de sélection 
Ajouter :	 permet de quitter le mode Supprimer pour ajouter à nouveau des objets à la sélection 
TOUT :	 sélectionne tous les objets du dessin 
annUler :	 annule la dernière sélection sans quitter la commande en cours.

 Vous pouvez retirer des objets de la sélection en utilisant une des méthodes précédentes tout en maintenant la 
touche MAJ (SHIFT) enfoncée.

 Une fois que tous les objets souhaités sont en surbrillance (pointillés), il faut valider la sélection en appuyant sur 
ENTREE pour poursuivre le déroulement de la commande. 
La plupart des commandes de modification permettent de sélectionner des objets avant de lancer la commande. Dans 
ce cas, il n’est pas nécessaire de valider.
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Sélection rapide

Outils > Sélection rapide, ou  (dans la fenêtre Propriétés)

Cette boîte de dialogue permet de sélectionner facilement des objets correspondant à certains critères. Vous pouvez 
filtrer par type d’objet, et/ou d’après une propriété supplémentaire.

A
B
C

D
E

F

G

A. Sélectionne des objets dans le dessin entier, ou dans le jeu de sélection courant uniquement (si des 
objets sont sélectionnés). Le bouton Choix des objets permet de créer une sélection.

B. Permet de spécifier le type d’objet à sélectionner. La liste n’affiche que les types d’objets présents dans 
le dessin. Choisissez Multiple pour ne pas restreindre la sélection à un type d’objet donné.

C. Permet de filtrer la sélection d’après une propriété générale (calque, couleur, etc.), ou propre au type 
d’objet choisi (nom du bloc, largeur de polyligne, etc.).

D. Permet de choisir un type de correspondance pour la valeur de la propriété (Egal à, Différent de, 
Supérieur à, etc.). Choisissez tout sélectionner pour ne filtrer que d’après le type d’objet, sans préciser de 
propriété supplémentaire.

E. Permet de définir la valeur pour la propriété filtrée. Selon le cas, il faudra choisir dans une liste 
déroulante, ou entrer une valeur.

F. Permet de choisir s’il faut sélectionner les objets correspondant aux critères, ou tous les objets sauf 
ceux répondant aux critères.

G. Permet d’ajouter les objets sélectionnés à la sélection courante, s’il en existe une. Si la case n’est pas 
cochée, la sélection courante sera remplacée.

 La commande peut être utilisée plusieurs fois d’affilée pour créer une sélection plus complexe (filtre d’après 
plusieurs propriétés.)
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Effacer

Modification > Effacer (EF), ou 

Permet de supprimer du dessin les objets sélectionnés. Vous pouvez également sélectionner des objets, puis appuyer 
sur la touche SUPPR.

Copier des objets

Modification > Copier (CP), ou 

Permet de copier les objets sélectionnés. Indiquez un point de départ, puis un point d’arrivée (en cliquant, ou entrant 
des coordonnées ou une distance).

Options :

Multiple :	 permet de copier la même sélection plusieurs fois (par défaut depuis AutoCAD 2005).

Miroir

Modification > Miroir (MI), ou 

Permet de créer une symétrie des objets sélectionnés, par rapport à un axe défini par deux points. Vous pouvez effacer 
ou conserver les objets d’origine.

 La variable système MIRRTEXT détermine si le miroir est appliqué ou non aux textes et attributs sélectionnés. 
Affectez-lui la valeur 0 pour conserver des textes lisibles.

Décaler

Modification > Décaler (DC), ou 

Crée un objet parallèle à partir d’un objet existant, soit à une distance donnée, soit passant par un point que vous 
indiquez.

Options :
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Par :	 permet de décaler un objet en passant par le point indiqué 
Effacer :	 permet d’effacer l’objet d’origine après l’avoir décalé (AutoCAD 2006) 
Calque :	 permet de choisir si l’objet est créé sur le même calque que l’objet source (par défaut), ou sur le 
calque courant (AutoCAD 2006) 
annUler :	 permet d’annuler le dernier décalage sans quitter la commande (AutoCAD 2006).

Réseau

Modification > Réseau (RE), ou 

Permet de créer des copies multiples d’une sélection selon un motif rectangulaire ou polaire (circulaire).

Le réseau rectangulaire permet de recopier la sélection en indiquant le nombre de rangées et de colonnes du motif 
rectangulaire, ainsi que les espacements entre les rangées et colonnes.

 Avec des décalages positifs, le réseau se fera vers la gauche et vers le haut. Des valeurs négatives permettent de 
créer un réseau vers la droite ou vers le bas.

Le réseau polaire permet de créer des copies multiples d’une sélection en rotation autour d’un centre.
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Déplacer

Modification > Déplacer (DP), ou 

Permet de déplacer les objets sélectionnés. Indiquez un point de départ, puis un point d’arrivée (en cliquant, ou 
entrant des coordonnées ou une distance).

Options :

Déplacement :	 permet d’entrer des valeurs de déplacement en X, Y et Z, au lieu d’indiquer les points de départ et 
d’arrivée (AutoCAD 2006).

 Vous pouvez également déplacer des objets de manière moins précise, en les faisant glisser : sélectionner les 
objets, placez le curseur sur la sélection (pas sur une poignée), et déplacez la souris en maintenant le bouton de 
gauche appuyé. Si vous maintenez le bouton de droite, un menu vous permettra de choisir entre un déplacement et 
une copie de la sélection.

Rotation

Modification> Rotation (RI), ou 

Permet de faire pivoter la sélection d’un angle donné, en indiquant un point comme centre de rotation.

Spécifiez le point de base: 
Spécifiez l’angle de rotation ou [Référence]: 45

Options :

Référence :	 permet d’indiquer un angle de base et un angle de destination, plutôt qu’un angle de rotation 
Copier :	 permet de créer une copie en rotation (AutoCAD 2006).

Spécifiez le point de base: 
Spécifiez l’angle de rotation ou [Référence]: r 
Spécifiez l’angle de référence <0>: 15 
Spécifiez le nouvel angle: 45
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Echelle

Modification> Echelle (EH), ou 

Permet de modifier les dimensions des objets sélectionnés en leur appliquant un facteur d’échelle uniforme.

Spécifiez le point de base: 
Spécifiez le facteur d’échelle ou [Référence]: 2

 Entrez un facteur compris entre 0 et 1 pour réduire les dimensions des objets sélectionnés.

Options :

Référence :	 définit l’échelle des objets sélectionnés en fonction d’une longueur de référence et d’une nouvelle 
longueur définie 
Copier :	 permet de créer une copie lors de la mise à l’échelle (AutoCAD 2006).

Etirer

Modification > Etirer (E), ou 

Permet d’étirer une partie de la sélection. A l’invite de choix des objets, il est impératif d’inclure dans une fenêtre de 
capture (ou un polygone de capture) les sommets à déplacer. 
Avec AutoCAD 2006, il est possible de sélectionner les objets à étirer à l’aide de plusieurs captures successives.

Options :

Déplacement :	 permet d’entrer des valeurs de déplacement en X, Y et Z, au lieu d’indiquer les points de départ et 
d’arrivée (AutoCAD 2006).

Modifier la longueur

Modification > Modifier la longueur (MG), ou 

Permet de connaître la longueur d’un objet, et de modifier cette longueur ou l’angle décrit par un arc.
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Options :

DIfférence : 	 modifie la longueur d’un objet selon un incrément défini, mesuré à partir de l’extrémité la plus 
proche du point de sélection 
Pourcentage : 	 définit la longueur d’un objet selon un pourcentage défini de sa longueur totale 
Total : 	 spécifie la longueur d’un objet sélectionné en définissant sa nouvelle longueur totale 
Dynamique : 	 permet de modifier la longueur d’un objet en faisant glisser l’une de ses extrémités à la souris.

Ajuster

Modification > Ajuster (AJ), ou 

Permet d’ajuster un ou plusieurs objet(s) par rapport à un ou plusieurs autre(s) objet(s) utilisé(s) comme bord(s) de 
coupe. 
Sélectionnez d’abord le(s) objet(s) à utiliser comme bord(s) de coupe, puis validez.

 Vous pouvez également appuyer sur ENTREE sans sélectionner aucun objet. AutoCAD utilisera alors 
automatiquement le bord de coupe le plus proche.

Cliquez ensuite sur les morceaux à supprimer, ou appuyez sur la touche MAJ pour prolonger (AutoCAD 2002).

 A l’invite de choix des objets à ajuster, tapez T pour sélectionner à l’aide d’un trajet plusieurs objets à ajuster. 

Options :

Côté : 	 permet de choisir entre les modes Prolongement (prise en compte des intersections virtuelles) et PAs 
de prolongement (par défaut) 
annUler : 	 permet de rétablir le dernier objet ajusté 
Projection : 	 spécifie la projection utilisée par AutoCAD lors de l’ajustement d’objets non coplanaires 
Trajet :	 permet de choisir les objets à ajuster à l’aide d’un trajet de sélection. Cette option est affichée dans 
AutoCAD 2006, mais fonctionne dans toutes les versions antérieures 
Capture :	 permet de choisir les objets à ajuster à l’aide d’une fenêtre de capture (AutoCAD 2006).

Prolonger

Modification > Prolonger (PR), ou 

Permet de prolonger un ou plusieurs objet(s) jusqu’à un ou plusieurs autre(s) objet(s) utilisé(s) comme limite(s). 
Sélectionnez d’abord le ou les objet(s) à utiliser comme limite(s), puis validez.

 Vous pouvez également appuyer sur ENTREE sans sélectionner aucun objet. AutoCAD utilisera alors 
automatiquement la limite la plus proche.

Cliquez ensuite sur les objets à prolonger, ou appuyez sur la touche MAJ pour ajuster (AutoCAD 2002).
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 A l’invite de choix des objets à prolonger, tapez T pour sélectionner à l’aide d’un trajet plusieurs objets à 
prolonger.

Options :

Côté : 	 permet de choisir entre les modes Prolongement (prise en compte des intersections virtuelles) et PAs 
de prolongement (par défaut) 
annUler : 	 permet de rétablir le dernier objet prolongé 
Projection : 	 spécifie la projection utilisée par AutoCAD lors du prolongement d’objets non coplanaires 
Trajet :	 permet de choisir les objets à prolonger à l’aide d’un trajet de sélection. Cette option est affichée 
dans AutoCAD 2006, mais fonctionne dans toutes les versions antérieures 
Capture :	 permet de choisir les objets à prolonger à l’aide d’une fenêtre de capture (AutoCAD 2006).

Couper au point

Permet de couper un objet en un point, pour obtenir deux objets avec une extrémité commune.

Coupure

Modification > Coupure (CU), ou 

Permet d’effacer le morceau d’objet situé entre les deux points de coupure choisis. Par défaut, le premier point de 
coupure correspond au point cliqué pour sélectionner l’objet. Utilisez l’option 1er point pour en choisir un autre.

 

Joindre

Modification > Joindre (J), ou  (AutoCAD 2006)

Permet de joindre des segments individuels de lignes, cercles, arcs elliptiques et splines en un seul objet. Les objets de 
départ doivent être «colinéaires».
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Chanfrein

Modification > Chanfrein (CF), ou 

Permet de raccorder des lignes ou des polylignes par un chanfrein (segment de droite). La commande chanfrein 
fonctionne comme la commande RACCORD (voir ci-dessous), seul le raccord est différent. 
Utilisez les options Ecart ou ANgle pour spécifier les valeurs du chanfrein.

Raccord

Modification> Raccord (RD), ou 

Permet de créer un arc tangent à deux objets (lignes, polylignes, arcs, cercles), et d’un rayon donné. En mode Ajuster, 
les objets sélectionnés seront ajustés ou prolongés automatiquement si nécessaire.

Options :

Polyligne : 	 permet d’arrondir tous les sommets d’une polyligne 
Rayon : 	 permet de définir le rayon du raccord 
Ajuster : 	 permet de choisir entre les modes Ajuster et  Non-ajuster 
Multiple : 	 permet de créer plusieurs raccords sans avoir à répéter la commande (AutoCAD 2005) 
annUler :	 permet d’annuler le dernier raccord (AutoCAD 2006).

 Avec AutoCAD 2006, appuyez sur la touche SHIFT en sélectionnant les objets pour les raccorder avec un rayon 
de 0, quel que soit le rayon courant.

Décomposer

Modification > Décomposer (DE), ou 

Décompose un objet complexe (polyligne, bloc, groupe, région, hachures…) en objets plus simples. Il peut être 
nécessaire de décomposer plusieurs fois selon la structure de l’objet (blocs imbriqués par exemple), avant d’obtenir 
des entités impossibles à décomposer (lignes, arcs, cercles).

 Décomposer des objets tels que des cotes, des blocs ou des hachures limite fortement les possibilités d’édition, 
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et augmente la taille du fichier.

Modification à l’aide des poignées

Les poignées permettent de modifier des objets du dessin sans lancer de commande. Un clic sur l’objet sélectionne ce 
dernier (il se met en pointillé) et fait apparaître ses poignées. Elles apparaissent aux points caractéristiques (extrémité, 
centre, milieu, point d’insertion) de l’objet.

Sélectionnez une poignée pour étirer ou déplacer l’objet. Maintenez la touche MAJ enfoncée pour sélectionner 
plusieurs poignées. 
Utilisez le clic droit pour afficher plus d’options. 
Utilisez la touche ECHAP pour désélectionner les objets et faire disparaître les poignées.

Options des poignées

Outils > Options > onglet Sélection (OP)

Cet onglet permet d’activer/désactiver l’affichage des poignées, et de modifier leurs couleurs. Vous pouvez choisir un 
nombre d’objets au delà duquel les poignées ne sont plus affichées (AutoCAD 2005).
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Propriétés

Outils > Propriétés (CTRL+1), ou  (barre d’outils Standard)

La fenêtre des Propriétés permet de visualiser et modifier les paramètres du (des) objet(s) sélectionné(s). 
Elle peut être ancrée sur un bord de l’écran, ou flottante dans la zone graphique. Dans ce cas, elle peut être 
paramétrée pour se masquer automatiquement lorsque le curseur quitte la fenêtre, et réapparaître lorsque le curseur 
revient se placer au-dessus d’elle (AutoCAD 2004).

B C DA

F

G

E

A. Affiche le type d’objet sélectionné, et le nombre d’objets sélectionnés. Si plusieurs objets de types 
différents sont sélectionnés, la fenêtre n’affiche que les propriétés qui existent pour tous les types d’objets. 
Déroulez la liste pour choisir le type d’objet à modifier, et afficher ses propriétés caractéristiques.

B. Permet d’activer ou désactiver la variable PICKADD, qui détermine si la touche MAJ doit ou non être 
enfoncée pour pouvoir sélectionner plusieurs objets en cliquant dessus successivement (voir Options de 
sélection).

C. Permet de sélectionner des objets dans le dessin.

D. Affiche la fenêtre Sélection rapide.
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E. Sélectionnez une propriété pour modifier sa valeur.

F. Cliquez ici pour choisir si la fenêtre Propriétés doit ou non être masquée automatiquement (AutoCAD 
2004).

G. Affiche les options de la fenêtre (AutoCAD 2004). Vous pouvez également utiliser le clic droit sur la 
fenêtre.

 Vous pouvez afficher la fenêtre Propriétés en double-cliquant sur un objet pour lequel il n’existe pas de 
commande d’édition spécifique.

Copier les propriétés

Modification> Copier les propriétés (COR), ou 

Permet de copier les propriétés (couleur, calque, type de ligne, style de texte, motif de hachure, etc.) d’un objet 
source vers un ou plusieurs objet(s).

Options :

PAramètres :	 affiche la boîte de dialogue ci-dessous, qui permet de choisir précisément les propriétés à copier.
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Renseignements

Les commandes suivantes permettent d’obtenir des renseignements divers (distances, aires, etc.) directement dans le 
dessin. Vous les trouverez dans le menu Outils > Renseignements, ou dans la barre d’outils Renseignements.

Distance

Outils > Renseignements > Distance (DI), ou 

Cliquez deux points pour connaître la distance qui les sépare. AutoCAD vous indique également les distances 
projetées sur les axes X, Y et Z, ainsi que l’angle dans le plan XY et l’angle par rapport au plan XY. 
Ces informations s’affichent dans la ligne de commande.

Aire

Outils > Renseignements > Aire (AI), ou 

Permet de mesurer une surface définie en cliquant des points. AutoCAD calcule l’aire de la surface obtenue en reliant 
les points en ligne droite, et l’affiche dans la ligne de commande.

Options :

Objet :	 permet de sélectionner un objet du dessin (polyligne, cercle, région, etc.) pour connaître sa surface 
Addition :	� permet de mesurer plusieurs aires successivement, AutoCAD se chargeant de les additionner au fur et 

à mesure
Soustraction :	� permet de mesurer plusieurs aires successivement, AutoCAD se chargeant de les soustraire au fur et à 

mesure.

Propriétés mécaniques

Outils > Renseignements > Propriétés mécaniques, ou 

Cette commande permet d’obtenir des renseignements propres aux régions 2D et aux solides 3D : surface, volume, 
coordonnées du centre de gravité, moments d’inertie, etc.

Liste

Outils > Renseignements > Liste, ou 

Affiche les caractéristiques de tous les objets sélectionnés. 
Cette commande permet par exemple de connaître les coordonnées de tous les sommets d’une polyligne.



56

Localiser un point

Outils > Renseignements > Localiser un point (ID), ou 

Permet de connaître les coordonnées du point cliqué.
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Calques et propriétés des objets

Les propriétés

Généralités

Il existe dans AutoCAD un certain nombre de propriétés générales, communes à tous les objets. 
En effet, tous les objets d’un dessin se verront attribuer : 
• un calque 
• une couleur 
• un type de ligne (continu, pointillés, etc.) 
• une épaisseur de tracé 
• un style de tracé (en cas d’utilisation des styles de tracés nommés uniquement).

Gestion des propriétés

Format > Calque, Couleur, Type de ligne, ou Epaisseur des lignes

Les barres d’outils Calques et Propriétés des objets permettent de gérer les propriétés des objets du dessin. Vous 
pouvez également utiliser la fenêtre des Propriétés.

A B C D E

A. Contrôle du calque.

B. Contrôle de la couleur.

C. Contrôle du type de ligne.

D. Contrôle de l’épaisseur de tracé.

E. Contrôle du style de tracé.

Si aucun objet n’est sélectionné, ces contrôles affichent – et permettent de définir – les propriétés courantes. Celles-
ci s’appliquent automatiquement aux nouveaux objets créés.

Si un objet est sélectionné (ou plusieurs), ce sont ses propriétés qui sont affichées dans les contrôles. Vous pouvez 
alors utiliser les contrôles pour modifier les propriétés du (des) objet(s) sélectionné(s), sans passer par la fenêtre 
Propriétés.

 Pour une gestion efficace des propriétés des objets, il est fortement conseillé d’utiliser les calques. Dans ce cas, 
tous les contrôles de la barre d’outils Propriétés des objets doivent être définis sur Ducalque.
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Les calques

Principe

Les calques sont comparables à des feuilles transparentes sur lesquelles vous pouvez organiser et grouper les objets du  
dessin. 
Les calques sont utilisés pour regrouper par fonction les objets d’un dessin (ex : calques Murs, Mobilier, Sanitaire, 
etc. pour un dessin de bâtiment ; calques Fort, Axes, Hachures, etc. pour un dessin mécanique), et leur appliquer 
facilement des normes de type de ligne, de couleur, d’épaisseur de tracé. Ils permettent donc de gérer plus facilement 
les propriétés des objets. 
Les calques peuvent être verrouillés, pour éviter toute modification des objets, ou masqués, pour faciliter le travail à 
l’écran ou imprimer différentes versions du dessin.

Gestionnaire des calques

Format > Calque (PL), ou 

Les calques sont gérés à l’aide du Gestionnaire de calques.

A

B

A. L’Arborescence des calques affiche la liste des filtres et groupes de calques du dessin. Elle peut être 
affichée ou masquée à volonté.

B. La liste des calques permet de gérer les calques du dessin. Cliquez sur un en-tête de colonne pour 
trier les calques par nom, visibilité, couleur, etc. Pour changer les propriétés d’un calque, cliquez sur un 
symbole, le carré de couleur, le type de ligne, etc.
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Créer des calques

Pour créer un calque, cliquez sur le bouton  dans le Gestionnaire des calques. Le nom du nouveau calque étant en 
surbrillance, vous pouvez directement le modifier. 

Modifier les propriétés de calques

Cliquez sur une propriété de couleur, type de ligne, épaisseur, pour afficher une boîte de dialogue permettant de la 
modifier. 
Pour utiliser un type de ligne qui n’est pas disponible dans le dessin, cliquez sur le bouton Charger, et importez-le.

 Vous pouvez sélectionner et modifier plusieurs calques à l’aide des touches CTRL ou MAJ.

Filtres et groupes de calques

Lorsqu’un dessin comporte des calques en grand nombre, vous pouvez utiliser des filtres et groupes de calques pour 
n’afficher dans le Gestionnaire que les calques dont vous avez besoin.

Un filtre permet de filtrer les calques d’après leur nom ou d’autres propriétés. 

Pour créer un filtre, cliquez sur le bouton  pour afficher la boîte de dialogue suivante.



60

Un groupe de calques correspond à un ensemble de calques que vous choisissez librement. 

Pour créer un nouveau groupe, cliquez sur le bouton . Vous pouvez ensuite sélectionner des calques dans la liste et 
les faire glisser dans le nouveau groupe.

Si vous sélectionnez un filtre ou un groupe dans l’arborescence, seuls les calques concernés seront affichés dans la liste 
des calques. Vous pouvez également afficher tous les calques sauf ceux faisant partie du filtre ou du groupe, en cochant 

la case . 

Si la case  est cochée, le filtre ou le groupe s’appliquera également à la liste des calques de 
la barre d’outils Calques.

Activer / désactiver un calque

Cliquez sur l’icône  dans le Gestionnaire de calques ou la liste déroulante de la barre d’outils Calques pour 
désactiver un calque. 
Lorsqu’un calque est désactivé , tous les objets se trouvant sur ce calque ne sont plus ni affichés, ni imprimés. Il est 
préférable de désactiver un calque lorsque l’on a souvent besoin de le réactiver, puisque la réactivation du calque ne 
provoque pas une régénération du dessin (contrairement à la libération d’un calque gelé).

 Le calque courant peut être désactivé. Attention, car si vous dessinez sur un calque désactivé, les objets créés ne 
seront affichés qu’une fois le calque réactivé !

Geler / libérer un calque

Cliquez sur l’icône  dans le Gestionnaire de calques ou la liste déroulante de la barre d’outils Calques pour geler 
un calque. 
Lorsqu’un calque est gelé , tous les objets se trouvant sur ce calque ne sont plus ni affichés, ni régénérés, ni 
imprimés. Le gel des calques diminue le temps de régénération et les performances d’affichage. Le calque courant ne 
peut pas être gelé.

Verrouiller / déverrouiller un calque

Cliquez sur l’icône  dans le Gestionnaire de calques ou la liste déroulante de la barre d’outils Calques pour 
verrouiller un calque. 
Lorsqu’un calque est verrouillé , les objets se trouvant sur ce calque ne peuvent plus être modifiés. Vous pouvez 
toutefois dessiner sur un calque verrouillé.
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Tracer / ne pas tracer un calque

Cliquez sur l’icône  dans le Gestionnaire de calques pour désactiver le tracé d’un calque. 
Lorsque le tracé d’un calque est désactivé , aucun des objets se trouvant sur ce calque ne sera imprimé, bien qu’ils 
puissent apparaître à l’écran.

Gestion des calques dans les fenêtres

Dans un onglet de présentation, vous avez la possibilité de gérer séparément la visibilité d’un calque dans les 
différentes fenêtres. Pour cela, utilisez les icônes Geler dans la fenêtre courante et Geler dans les nouvelles fenêtres.

Etats de calques

Vous pouvez enregistrer sous la forme d’un état de calques les paramètres et les propriétés (visibilité, couleur, etc.) 
de tous les calques du dessin à un instant donné (AutoCAD 2002). Vous pouvez choisir précisément les paramètres ou 
propriétés à mémoriser. 
Une fois que plusieurs états de calques ont été enregistrés, vous pouvez restaurer facilement un de ces états. 

Pour créer ou restaurer un état de calques, utilisez le bouton  pour afficher le Gestionnaire des états.

Supprimer un calque

Pour supprimer un calque, sélectionnez-le dans le Gestionnaire et cliquez sur le bouton . 
Seul un calque non référencé peut être supprimé, il n’y a donc aucun risque de supprimer des objets dans le dessin.

 Pour pouvoir être supprimé, un calque ne doit pas être le calque courant, ne doit contenir aucun objet, et ne pas 
être référencé par une définition de bloc. S’il est impossible de supprimer un calque, essayez en purgeant le dessin.
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Choix du calque courant

Le calque courant est celui auquel appartiendront tous les nouveaux objets créés. 

Vous pouvez choisir le calque courant dans le Gestionnaire de calques avec le bouton , ou en le sélectionnant dans 
la liste des calques de la barre d’outils Calques.

Vous pouvez également rendre courant le calque d’un objet sélectionné avec .

Convertisseur de calques

Outils > Normes CAO > Convertisseur de calques, ou  (barre d’outils Normes CAO)

Cet outil permet de sélectionner des calques du dessin, et de les convertir vers de nouveaux paramètres (nom, 
couleur, etc.).

Dans la liste Convertir de, sélectionnez un (ou plusieurs) calque à convertir, et sélectionnez un calque cible dans 
la liste Convertir en. Les calques cibles peuvent être chargés depuis un fichier ( DWG, DWT, ou DWS), ou créés 
directement avec le bouton Nouveau. Si plusieurs calques sont assignés à un seul calque cible, ils seront fusionnés en 
un seul calque. 
Cliquez ensuite sur le bouton Assigner. Répétez la même procédure autant de fois que nécessaire. 
Une fois que tous les calques à convertir ont été assignés à un calque cible, cliquez sur le bouton Convertir.



63

Annotation d’un dessin

Le texte

Vous trouverez les différents outils de texte dans la barre d’outils Texte :

Style de texte

Format > Style de texte (ST), ou 

Cette boîte de dialogue permet de créer des styles de texte, qui pourront ensuite être utilisés pour la création de 
texte (outils de texte, cotation, tableaux). 
Un style de texte est constitué d’une police de caractères, et facultativement d’un ou plusieurs styles de police (gras, 
italique, souligné, pour les polices TrueType uniquement), d’une hauteur, et d’un ou plusieurs effets (renversé, reflété, 
etc.).

 Gardez obligatoirement une hauteur de 0 pour le style de texte qui sera utilisé pour les textes des cotes.

Vous pouvez choisir le style de texte courant dans la barre d’outils Styles :

Texte sur une ligne

Dessin > Texte > Ligne (TD), ou 

Permet de créer une seule ligne de texte. 
Chaque pression sur ENTREE commence une nouvelle ligne, chaque ligne étant un objet indépendant. Appuyez sur 
ENTREE deux fois pour terminer la commande.
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Options :

Style : 	 permet de choisir un style de texte 
Justifier : 	 permet de choisir une option de justification, qui déterminera la position du texte par rapport à son 
point de base.

Texte multiligne

Dessin > Texte > Texte multiligne (TT), ou  (barre d’outils Texte ou Dessin)

Cette commande permet de créer un bloc de texte de largeur définie. 
Cliquez deux points pour tracer un rectangle, qui définira la largeur du paragraphe.

Une fois la fenêtre tracée, l’éditeur de texte multiligne s’affiche :

La barre Format du texte permet de choisir le style de texte, la police, la hauteur du texte (en unités de dessin). Vous 
pouvez également mettre le texte en gras, italique, ou souligné (si la police le permet), empiler du texte, changer sa 
couleur. La barre comporte ses propres boutons Annuler et Rétablir, et un bouton OK qui permet de valider le texte.

Au fur et à mesure de la saisie, le texte passe automatiquement à la ligne lorsqu’il rencontre la fin du paragraphe. 
Appuyez sur ENTREE pour commencer un nouveau paragraphe, ou sur MAJ+ENTREE pour insérer un saut de ligne 
dans le paragraphe courant.Utilisez le menu contextuel (clic droit) pour plus d’options : choix de la justification, 
insertion de symboles, etc.
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Editer un texte

Modification > Objet > Texte > Modifier (ED), ou 

Cliquez sur un bloc de texte multiligne pour afficher l’éditeur, ou sur un texte simple pour le corriger directement.

Utilisez la fenêtre Propriétés pour modifier le formatage d’un texte simple (hauteur, style de texte, etc.).

 Il est beaucoup plus rapide de double-cliquer sur un texte pour l’éditer.

Rechercher / remplacer

Edition > Rechercher, ou 

Affiche la boîte de dialogue ci-dessous, qui permet de rechercher et de remplacer du texte. Vous pouvez lancer la 
recherche dans le dessin entier, ou effectuer une sélection. 
Vous pouvez choisir dans les options de la commande les types d’objets à prendre en compte (texte, textes des cotes, 
attributs, etc.).

Mettre le texte à l’échelle

Modification > Objet > Texte > Echelle, ou 

Permet de donner une nouvelle hauteur à tous les textes sélectionnés. 
Le point de base utilisé peut être le point de base respectif de chaque texte, ou peut être choisi globalement (Milieu 
Centre par exemple). 
La nouvelle hauteur peut être définie de trois façons différentes : 
• en entrant une nouvelle hauteur en unités 
• avec l’option Correspondance objet : sélectionnez un texte source, et tous les textes sélectionnés prendront la même 
hauteur que celui-ci 
• avec l’option Facteur échelle : entrez un facteur (ex : 2 pour doubler la hauteur de tous les textes sélectionnés, 0.5 
pour la réduire de moitié).
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Justifier le texte

Modification > Objet > Texte > Justifier, ou 

Modifie le point de justification des objets texte sélectionnés sans les déplacer. 
En effet, si vous utilisez la fenêtre Propriétés pour modifier la justification, le point de base reste fixe et c’est le texte 
qui se déplace.

Convertir la distance entre les espaces

Disponible uniquement dans les onglets de présentation, cette commande permet de convertir une valeur de l’espace 
Papier en son équivalent dans l’espace Objet, ou inversement. 
Elle est par exemple très pratique pour calculer la hauteur à donner à un texte créé en espace Objet en fonction de la 
hauteur voulue sur le papier et de l’échelle de la fenêtre. 
Cette commande peut être utilisée de manière transparente pour entrer la hauteur du texte pour la commande Texte 
sur une ligne par exemple, ou toute autre commande demandant une valeur dans la ligne de commande.

Champs de texte 

Insertion > Champ (AutoCAD 2005)

Un champ est un texte particulier, dont la valeur reflète une propriété du dessin (auteur, description, etc.), d’un objet 
du dessin (longueur, aire, etc.), ou une date. Les champs peuvent être mis à jour en cas de modification du dessin. 
Sélectionnez une catégorie de champ, un objet (pour la catégorie Objets), un type de champ, un format, puis cliquez 
sur OK pour insérer le champ dans le dessin. 
Dans l’exemple ci-dessous, un champ affichant l’aire d’un polygone a été inséré dans le dessin :

 

 Vous pouvez également insérer un champ dans l’éditeur de texte multiligne, à l’aide du menu contextuel.

Mise à jour d’un champ

Outils > Mettre à jour les champs

Un champ de texte n’est pas mis à jour automatiquement lorsque la propriété à laquelle il est lié est modifiée. Il est 
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donc nécessaire de mettre à jours les champs manuellement à l’aide de cette commande.

Les tableaux

Une des nouveautés d’AutoCAD 2005 est l’apparition d’outils permettant la création de tableaux. 
Ces outils permettent une mise en forme simple et rapide de tableaux pour créer par exemple des nomenclatures, 
listes de pièces, légendes, etc.

Styles de tableau

Format > Style de tableau, ou  (barre d’outils Styles)

Avant de dessiner des tableaux, vous pouvez créer un ou plusieurs styles de tableau. Un style de tableau permet de 
définir tous les paramètres de mise en forme du tableau : styles de texte utilisés, couleurs des texte et bordures, 
position du texte dans les cellules, etc.

La boîte de dialogue comporte trois onglets, permettant de formater différemment les cellules des lignes de données, 
de la ligne d’en-têtes, et de la ligne de titre. 
Les lignes d’en-têtes et de titre peuvent être désactivées.

Si vous modifiez un style de tableau, les tableaux basés sur ce style seront automatiquement mis à jour.
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Insérer un tableau

Dessin > Tableau, ou  (barre d’outils Dessin)

Affiche la boîte de dialogue suivante, qui permet de définir le nombre de colonnes et de rangées du nouveau tableau, 
la largeur des colonnes et hauteur des lignes, ainsi que le style de tableau à utiliser.

Après avoir cliqué sur OK, cliquez un point pour positionner le tableau dans le dessin. Vous pouvez ensuite 
directement entrer du texte dans les cellules. Appuyez sur la touche TAB ou les flèches de direction pour passer de 
cellule en cellule. Cliquez sur OK après avoir entré le texte.

Modifier un tableau

Vous pouvez double-cliquer dans une cellule du tableau pour modifier le texte de la cellule. 
Vous pouvez également sélectionner une cellule en cliquant dedans, ou sélectionner le tableau complet, puis utiliser 
les poignées ou la fenêtre Propriétés pour redimensionner le tableau entier, une colonne, une ligne, ou une cellule. 
Utilisez également le menu contextuel pour, par exemple, insérer des lignes et des colonnes.
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 Après avoir sélectionné une cellule, maintenant la touche MAJ enfoncée pour en sélectionner d’autres.

Formules

AutoCAD 2006 permet d’utiliser des formules dans un tableau. 
Pour insérer une formule, sélectionner une cellule puis choisissez un type de formule dans le menu contextuel 
(clic droit). Vous pouvez également taper directement une formule sous forme d’un texte précédé du signe = (ex : 
=A1*B2).

La cotation

Les différents outils de cotation d’AutoCAD sont disponibles dans le menu Cotation, ou la barre d’outils Cotation :

Styles de cotes

Format > Style de cotes, Cotation > Style, ou 

Un style de cote correspond à un ensemble de paramètres définissant l’aspect des cotes du dessin. 
Il est possible de définir plusieurs styles de cotes dans un même dessin. 
D’une manière générale, un style de cote est défini avec les valeurs en mm (hauteur de texte, taille des flèches, etc.) 
que vous désirez obtenir sur le papier une fois le dessin tracé. La taille des cotes est ensuite ajustée en fonction de 
l’échelle du dessin à l’aide du facteur d’échelle général du style de cote (onglet Ajuster).
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Lorsqu’un nouveau style de cotes est créé, il est obligatoirement créé sur la base d’un style existant. Le style de cotes 
par défaut est ISO-25.

 
L’onglet Lignes permet de définir l’aspect (couleur, épaisseur, taille et espacements…) des lignes d’attaches et lignes 
de cote (voir figure suivante).

L’onglet Symboles et flèches permet de définir l’aspect des flèches, des marques au centre, et la position des symboles 
de longueur d’arc (AutoCAD 2006).

L’onglet Texte permet de définir l’aspect du texte de cote (style de texte utilisé, couleur, hauteur…).

L’onglet Ajuster permet de définir la position du texte de cote, ainsi que l’échelle générale des cotes. Ce dernier 
paramètre doit être réglé sur Echelle des cotes selon présentation lorsque la cotation est effectuée dans un onglet de 
Présentation (recommandé). Les cotes seront alors mises à l’échelle automatiquement.

L’onglet Unités principales permet de définir les paramètres du texte de cote (notation, précision, arrondi…).

L’onglet Unités principales permet d’afficher une deuxième valeur sur les cotes, correspondant à la conversion de 
l’unité principale vers une autre unité (selon le Multiplicateur des unités alternatives).

Enfin l’onglet Tolérance permet de définir les paramètres et l’aspect du texte des tolérances. Ces dernières ne sont 
toutefois généralement pas définies dans le style de cote, mais ajoutées par la suite à l’aide de la fenêtre Propriétés.

La figure ci-dessous présente les termes utilisés pour décrire les différentes parties d’une cote dans AutoCAD :
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B

A

E

C

D

A. Ligne d’attache

B. Ligne de cote

C. Etendre au-delà des lignes de cotes

D. Décalage de l’origine

E. Espacement des lignes de base

Le choix du style de cotes courant se fait dans la barre d’outils Cotation, ou la barre d’outils Styles :

Cotation linéaire / Alignée

Cotation > Linéaire / Alignée, ou  / 

La cotation linéaire permet de coter la distance horizontale ou verticale entre deux points, tandis que la cotation 
alignée cote la distance absolue entre deux points. 
Il suffit de cliquer les deux points d’attache de la cote, puis de cliquer pour positionner la ligne de cote.

Options :

• textMult : 	 affiche l’Editeur de texte multiligne, qui permet de modifier un texte de cote. AutoCAD représente 
la cote réelle par des chevrons (< >). Pour ajouter un préfixe ou un suffixe à la cote, entrez-le avant ou après les 
chevrons. Pour modifier ou remplacer la valeur, remplacez les chevrons par le nouveau texte de cote (cote forcée). 
• TExte : 	 idem que textMult, mais dans la ligne de commande 
• Angle : 	 modifie l’angle du texte de cote 
• Horizontale : 	 force la cote en horizontal 
• Verticale : 	 force la cote en vertical 
• Rotation : 	 permet de donner un angle aux lignes d’attaches.
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cotation de longueur d’arc

Cotation > Longueur d’arc, ou  (AutoCAD 2006)

Permet de coter la longueur développée d’un arc.

Cotation ordonnée

Cotation > Superposée, ou 

Permet de coter la coordonnée X ou Y d’un point. AutoCAD utilise le système de coordonnées courant pour 
déterminer les coordonnées. Pour utiliser un point particulier comme origine, vous pouvez déplacer le SCU au 
préalable. 
Cliquez un point à repérer, puis un point pour placer le texte.

Cote de rayon / diamètre

Cotation > Rayon / Diamètre, ou  / 

Permet de coter le rayon ou le diamètre d’un cercle ou d’un arc. Sélectionnez l’objet, puis cliquez un point pour 
placer la cote.

Pour les grands rayons, AutoCAD 2006 permet de créer une cote de rayon raccourcie .

Cotation Angulaire

Cotation > Angulaire, ou 

Permet de coter l’angle entre deux objets (sélectionner les objets, puis placer la cote), l’angle d’ouverture d’un arc 
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(sélectionner l’objet, puis placer la cote), ou un angle défini par trois points (appuyez sur ENTREE après avoir lancé la 
commande, cliquez les points, puis placez la cote). L’unité d’angle utilisée est définie dans le style de cote.

Cotation rapide

Cotation > Cotation rapide, ou 

Permet de créer rapidement une série de cotes. Cette commande est particulièrement utile pour créer une série de 
cotes de ligne de base ou continues, ou pour coter une série de cercles et d’arcs.

Sélectionnez la géométrie à coter, puis choisissez le type de cotes à créer à l’aide des options :

• Continue :	 crée une série de cotes continues 
• Décalée : 	 crée une série de cotes décalées 
• Ligne de base :		crée une série de cotes de ligne de base 
• Superposées : 	crée une série de cotes superposées 
• Rayon : 	 crée une série de cotes de rayon 
• Diamètre : 	 crée une série de cotes de diamètre 
• Pointréférence : 	 définit un nouveau point de référence pour les cotes de ligne de base ou superposées 
• Editer : 	 modifie une série de cotes 
• Paramètres : 	 définit l’accrochage aux objets par défaut pour spécifier les origines de la ligne d’attache.

Puis cliquez pour placer les cotes.

 Cotation de ligne de base

Cotation > Ligne de base, ou 

Permet de créer une série de cotes (linéaires, alignées, angulaires) à partir d’une même ligne de base. Cette 
commande nécessite qu’une première cote existe auparavant. La cote prise comme référence est la dernière créée, 
mais vous pouvez appuyer sur ENTREE pour pouvoir sélectionner la ligne d’attache à utiliser comme référence.

Cotation continue

Cotation > Continue, ou 

Permet de créer une série de cotes adjacentes (chaîne de cotes). Cette commande nécessite qu’une première cote 
(linéaire, alignée, ordonnée, angulaire) existe auparavant. La cote prise comme référence est la dernière créée, mais 
vous pouvez appuyer sur ENTREE pour pouvoir sélectionner la ligne d’attache à utiliser comme référence.

Repère

Cotation > Repère, ou 

Utilisez cette commande pour créer rapidement des lignes de repère avec annotation. Appuyez sur ENTREE avant de 
cliquer le point de départ pour afficher la boîte de dialogue Paramètres, qui permet de contrôler précisément l’aspect 
des repères.
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Tolérance

Cotation > Tolérance, ou 

Permet de placer dans le dessin un bloc de tolérances géométriques.

Marque centrale

Cotation > Marque centrale, ou 

Crée une marque au centre du cercle ou de l’arc sélectionné. L’aspect est défini dans le style de cotes.

Edition des cotes

Pour modifier des cotes, vous pouvez : 
• sélectionner la (les) cote(s), et faire un clic droit. De nombreuses possibilités d’édition vous sont présentées dans le 
menu contextuel. 
• sélectionner la (les) cote(s), et utiliser la fenêtre Propriétés 
• utiliser une des commandes suivantes : Modifier la cote, Modifier le texte de la cote, Editer texte.

Modifier la cote

Cotation > Oblique (pour l’option Oblique), ou 

Sélectionnez une option, puis sélectionnez une ou plusieurs cote(s).

Options :
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Début : 	 replace le texte de cote pivoté à son emplacement par défaut 
Nouv : 	 permet de modifier le texte de toutes les cotes sélectionnées à l’aide de l’éditeur de texte multiligne. 
AutoCAD représente la mesure générée entre chevrons (< >). Pour ajouter un préfixe ou un suffixe à la valeur, 
entrez-le avant ou après les chevrons. 
Rotation : 	 fait pivoter le texte de cote 
Oblique : 	 règle l’angle d’inclinaison des lignes d’attache associées aux cotes linéaires.

Modifier le texte de cote

Cotation > Aligner le texte, ou 

Permet de modifier la position du texte de la cote sélectionnée, ou son angle.

Mettre à jour la cote

Cotation > Mettre à jour, ou 

Applique les paramètres du style de cote courant aux cotes sélectionnées.

Associativité des cotes

Depuis la version 2002, AutoCAD prend en charge deux nouvelles et puissantes fonctions de cotation : la cotation 
associative fondée sur la géométrie et la cotation Objet/Papier.

L’associativité fondée sur la géométrie permet d’attacher des cotes aux objets ou aux éléments les constituant. Les 
cotes sont mises à jour automatiquement en cas de déplacement ou de modification de la géométrie associée. Les 
lignes de repère sont également associatives. 

La cotation objet/papier permet de coter dans l’espace Papier la géométrie de l’espace objet . Ces cotes de l’espace 
Papier restent associatives dans les situations suivantes :  
• modification de la géométrie dans l’espace objet 
• déplacement de la fenêtre de présentation 
• application d’un panoramique ou d’un zoom dans une fenêtre de présentation.

Le type des cotes créées dépend de la variable DIMASSOC, qui peut prendre 3 valeurs : 
• 0 : 	 les cotes créées sont décomposées (à éviter) 
• 1 : 	 les cotes sont semi-associatives, comme dans les versions antérieures d’AutoCAD. C’est le cas 
lorsqu’un fichier d’une version antérieure est ouvert. 
• 2 : 	 les cotes sont totalement associatives. C’est le cas par défaut pour un nouveau dessin basé sur un 
brouillon.

Ce paramètre est sauvegardé dans le fichier. Lorsque vous commencez un dessin à partir d’un gabarit, la valeur en 
vigueur dans le fichier gabarit sera utilisée. 
Il peut également être modifié dans la boîte de dialogue Options, onglet Préférences utilisateur :
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Régénérer les cotes

Commande COTREGEN

Met à jour les positions de toutes les cotes associatives du dessin en cours. 
Les cotes associatives doivent être mises à jour manuellement avec la commande COTREGEN dans trois cas :

• �après un panoramique ou un zoom avec une souris à roulette dans une présentation avec l’espace objet actif, mettez 
à jour les cotes associatives créées dans l’espace papier.

• �après l’ouverture d’un dessin qui a été modifié avec une version précédente d’AutoCAD, mettez à jour les cotes 
associatives si les objets cotés ont été modifiés.

• �après l’ouverture d’un dessin contenant des références externes qui sont cotées dans le dessin courant, mettez à jour 
les cotes associatives si la géométrie de référence externe associée a été modifiée.
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Blocs, Xrefs et images

Les blocs

Principe

Dans AutoCAD, un bloc est un objet complexe nommé, constitué à partir de plusieurs objets (lignes, cercles, arcs, 
blocs imbriqués, etc.). 
Le bloc dans son ensemble est traité comme un objet unique. Il est possible de modifier l’échelle et l’angle de rotation 
à l’insertion du bloc. 
Contrairement à une simple copie d’objets, l’insertion de multiples occurrences d’un même bloc n’aura quasiment 
aucun impact sur le poids du fichier.

Il existe deux types de blocs : 
• Le bloc (bloc interne) : un bloc est sauvé uniquement dans le dessin en cours. On ne peut pas l’insérer dans d’autres 
dessins, sauf à l’aide du Design Center. 
• Le fichier bloc (Wbloc) : c’est un bloc exporté sous forme de fichier dwg indépendant. Il peut donc être inséré par 
la suite dans n’importe quel dessin, et permet de constituer une bibliothèque.

Les blocs, de manipulation simple, permettent de créer une bibliothèque d’éléments réutilisables.

Créer un bloc

Dessin > Bloc > Créer (B), ou  (barre d’outils Dessin)

Permet de créer un bloc à partir d’une sélection d’objets. Le bloc créé sera enregistré dans le dessin actif.

C

A

B

D

E

F

G

A. Entrez le nom du bloc à créer, ou sélectionnez un bloc existant pour le redéfinir.

B. Cliquez pour choisir le point de base du bloc, qui sera le point utilisé pour placer le bloc dans le dessin à 
l’insertion.
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C. Cliquez pour choisir les objets du dessin à partir desquels le bloc doit être créé.

D. Permet de choisir ce que vont devenir les objets sélectionnés une fois le bloc créé. Dans tous les cas, le 
bloc sera disponible dans le dessin.

E. Si une icône est créée, elle sera visible dans le Design Center.

F. Indiquez l’unité dans laquelle le bloc a été dessiné.

G. Entrez une description pour le bloc (facultatif).

Créer un bloc fichier

Commande WBLOC

Cette commande permet de créer un bloc qui sera enregistré en tant que fichier DWG indépendant, à l’emplacement 
spécifié. Le bloc peut être créé de plusieurs façons : 
• à partir d’objets sélectionnés (source : objets) 
• en exportant un bloc du dessin (source : bloc) 
• en exportant le dessin entier (source : dessin entier).

Insérer un bloc

Insertion > Bloc (I), ou  (barres d’outils Dessin et Insertion)

Permet d’insérer une occurrence d’un bloc défini dans le dessin, ou d’insérer un fichier en tant que bloc dans le dessin 
courant (cliquez sur Parcourir). 
Les coordonnées d’insertion, l’échelle du bloc et son angle de rotation peuvent être entrés dans la boîte de dialogue, 
ou définis après avoir cliqué sur OK (cochez les case Spécifier à l’écran).
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Point de base

Dessin > Bloc > Base

Il est possible d’insérer en tant que bloc dans le dessin courant tout autre fichier dessin. Le point d’insertion de ce 
dessin est par défaut le point d’origine du SCG. La commande BASE permet de modifier le point de base du fichier 
dessin à insérer.

Propriétés des blocs

Chaque entité constituant le bloc peut avoir des propriétés différentes de couleur, type de ligne et calque. Selon les 
valeurs d’origine de ces propriétés, l’insertion du bloc peut provoquer ou non une modification de l’aspect de chacun 
de ces objets.

Possibilités :

• Toute entité d’un bloc créée sur le calque 0 (avec couleur, type de ligne et épaisseur DUCALQUE) se placera, 
lors de l’insertion du bloc, sur le calque courant et prendra les caractéristiques de ce calque (couleur, type de ligne, 
épaisseur).

• Toute entité d’un bloc créée sur un autre calque que 0 (avec couleur, type de ligne et épaisseur DUCALQUE) restera 
placée sur ce calque, et gardera ses propriétés lors de l’insertion du bloc.

• Toute entité d’un bloc créée sur un autre calque que 0 (mais avec couleur, type de ligne et épaisseur DUBLOC) 
prendra les caractéristiques du calque courant (couleur, type de ligne,épaisseur).

Editer un bloc

Un bloc peut être décomposé. On retrouve alors les objets qui ont servi à le créer, mais tous les avantages liés à 
l’utilisation des blocs (attributs, poids du fichier minimisé, etc.) sont perdus.

Pour éditer un bloc sans le décomposer, utilisez la commande d’Edition des références. Toutes les occurrences du bloc 
dans le dessin seront alors mises à jour.
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Les attributs de bloc

Principe

Un attribut est un libellé ou une étiquette qui associe des données à un bloc. L’étiquette de l’attribut équivaut au 
nom d’un champ dans une table de base de données. Vous pouvez associer plusieurs attributs à un bloc, à condition 
de définir une étiquette différente pour chacun d’eux. Une utilisation typique des attributs concerne les champs d’un 
cartouche.

Il est possible d’extraire les informations des attributs d’un dessin pour les utiliser dans un tableur ou une base de 
données, afin de générer une liste de pièces ou une nomenclature par exemple.

Lorsque vous insérez un bloc disposant d’un attribut variable, AutoCAD vous invite à entrer les données associées à ce 
bloc. Si le bloc dispose uniquement d’attributs constants (valeur invariable), AutoCAD ne demande pas de valeur lors 
de l’insertion du bloc. 

Les attributs peuvent aussi être invisibles. Un attribut invisible n’est ni affiché ni tracé, toutefois l’information 
d’attribut est stockée dans le fichier dessin et peut être extraite.

Les commandes permettant la gestion des attributs se trouvent dans la barre d’outils Modifier II :

Définir les attributs

Dessin > Bloc > Définir les attributs (AT)

Cette commande permet de définir une étiquette d’attribut, qui sera ensuite associée à un bloc (en la sélectionnant 
lors du choix des objets constituant le bloc).

Etiquette : identifie chaque occurrence d’un attribut dans le dessin. L’étiquette est constituée de toute combinaison de 
caractères à l’exception d’espaces. Les minuscules sont converties en majuscules.

Invite : indique l’invite de l’attribut affichée lors de l’insertion d’un bloc contenant cette définition d’attribut. Si vous 



81

ne spécifiez pas l’invite, l’étiquette est utilisée comme invite par défaut. Si vous sélectionnez Constant dans la zone 
Mode, l’option Invite n’est pas disponible.

Valeur : spécifie la valeur par défaut de l’attribut (peut être vide). Depuis AutoCAD 2005, la valeur de l’attribut peut 
contenir des champs de texte.

Un attribut peut être défini suivant plusieurs modes : 
• Invisible : 	 indique que les valeurs d’attributs ne sont ni affichées ni imprimées lors de l’insertion du bloc. 
• Constant : 	 affecte aux attributs une valeur fixe. 
• Vérifié : 	 demande une vérification de la valeur des attributs lors de l’insertion du bloc. 
• Prédéfini : 	 établit la valeur par défaut de l’attribut. La valeur peut être modifiée en éditant les attributs.

Il faut également définir un point d’insertion, ainsi que les options de texte (hauteur, justification, rotation et style). 
Cela permet de positionner l’attribut par rapport aux objets auxquels il sera associé lors de la création du bloc.

Une fois toutes les définitions d’attributs créées, il faut créer un bloc contenant ces dernières ainsi que les autres 
entités à inclure dans le bloc. Lors de la sélection d’objets, vous pouvez sélectionner les étiquettes une par une afin de 
définir leur ordre d’apparition lors de l’insertion du bloc.

Editer les attributs

Modification > Objet > Attribut > Unique, ou 

Permet de modifier la valeur, l’apparence ou les propriétés des attributs du bloc sélectionné, sans altérer les autres 
occurrences de ce bloc dans le dessin.

L’onglet Attribut vous permet de modifier la valeur des attributs du bloc sélectionné.

L’onglet Options de texte vous permet de modifier l’aspect du texte de l’attribut sélectionné dans l’onglet Attribut 
(hauteur, style, etc.).

L’onglet Propriétés vous permet de modifier les propriétés (couleur, calque, etc.) de l’attribut sélectionné dans 
l’onglet Attribut.

 Vous pouvez double-cliquer sur un bloc contenant des attributs pour les éditer.

Gestionnaire des attributs de bloc

Modification > Objet > Attribut > Gestionnaire des attributs de bloc, ou 

Permet de gérer les définitions d’attributs de blocs du dessin. Les possibilités sont à peu de choses près les mêmes 
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qu’avec la commande précédente, mais les modifications s’appliquent cette fois à toutes les occurrences du bloc dans 
le dessin.

Synchroniser les attributs

Met à jour toutes les instances du bloc spécifié avec les propriétés courantes des attributs définis pour ce bloc.

Extraction d’attributs

Outils > Extraction d’attributs, ou 

L’extraction d’attributs permet de récupérer les informations des attributs de bloc du dessin (ou de plusieurs dessins),  
et d’enregistrer ces informations dans un fichier externe (format ASCII délimité par des virgules, ASCII délimité par 
des tabulations, Microsoft Excel ou Access si ces applications sont installées sur votre système). 

L’extraction étendue d’attributs est idéale pour générer par exemple un devis ou une nomenclature directement à 
partir des données du dessin. Il suffit pour cela de suivre l’assistant pas à pas.

Les références externes (Xrefs)

Principes

Les références externes (Xrefs) sont des fichiers AutoCAD insérés dans votre dessin à la manière d’un fichier bloc. La 
différence vient du fait que le fichier référencé est lié au fichier dans lequel il est inséré (dessin hôte). 
AutoCAD recherche le fichier Xref et le charge à chaque ouverture du dessin hôte. 
Si vous transmettez le dessin à quelqu’un, le fichier référencé doit donc être joint au fichier principal (voir la fonction 
eTransmit). 
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Si le fichier externe a été modifié, la Xref sera mise à jour automatiquement à l’ouverture du dessin hôte

Les commandes relatives à la gestion des Xrefs se trouvent dans la barre d’outils Référence :

Attacher une référence externe

Insertion > Référence externe (XA), ou 

Cette commande permet d’insérer une nouvelle Xref dans le dessin. Après avoir désigné le fichier à insérer, une boîte 
de dialogue apparaît. Elle est quasiment identique à celle permettant l’insertion d’un bloc.

L’emplacement du fichier référencé peut être enregistré sous forme de chemin complet (chemin absolu), ou sous 
forme de chemin relatif (emplacement du fichier référencé par rapport à l’emplacement du dessin hôte).

Le type de référence détermine le comportement des Xref imbriquées. Contrairement aux Xrefs attachées, les Xrefs 
superposées ne sont pas affichées si vous insérez le dessin hôte sous forme de référence externe dans un autre dessin.

Gestionnaire des références externes

Insertion > Gestionnaire des références externes (XR), ou 

Cette commande fait apparaître une boîte de dialogue permettant de gérer les Xref.

Le bouton Attacher permet d’insérer une nouvelle Xref dans le dessin. 
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En sélectionnant une (ou plusieurs) Xref, vous pouvez cliquer sur : 
• Détacher : 	 permet de supprimer définitivement une Xref du dessin 
• Décharger : 	 permet de supprimer temporairement une Xref du dessin 
• Recharger : 	 fait réapparaître une Xref déchargée, ou rafraîchit une Xref modifiée 
• Ajouter : 	 transforme la Xref en bloc du dessin, et donc supprime tout lien avec le fichier externe 
• Ouvrir : 	 ouvre le fichier Xref (AutoCAD 2005) 
• Parcourir : 	 permet de modifier le chemin de la Xref (si le fichier de la Xref a été déplacé ou renommé par 
exemple) 
• Enregistrer chemin : 	 permet d’enregistrer définitivement le nouveau chemin de la Xref s’il a été modifié.

Délimiter une référence externe

Modification > Délimiter > Xréf, ou 

Permet de délimiter la Xref sélectionnée à l’aide d’un contour rectangulaire ou polygonal, pour n’en afficher qu’une 
partie. Cette commande fonctionne également pour les blocs.

Options :

• ACtif : 	 affiche uniquement la partie délimitée de la référence externe ou du bloc

• INactif : 	 affiche toute la géométrie de la référence externe ou du bloc, en ignorant le contour de délimitation

• Profdelim : 	 définit les plans de délimitation avant et arrière d’une référence externe ou d’un bloc. Les objets en 
dehors du volume défini par le contour et le chemin spécifié ne sont pas affichés

• Supprimer : 	 supprime un contour de délimitation pour la référence externe ou le bloc sélectionné. Pour 
temporairement désactiver un contour de délimitation, utilisez l’option INactif. La commande Supprimer efface le 
contour ainsi que la profondeur de délimitation.

• générer POlyligne : 	 dessine automatiquement une polyligne coïncidente avec le contour de délimitation. La 
polyligne assume le calque, le type de ligne et les paramètres courants. Cette option est utile pour modifier le contour 
de délimitation courant à l’aide de la commande PEDIT puis redéfinir le contour de délimitation avec la nouvelle 
polyligne. Pour visualiser la référence externe entière en redéfinissant le contour, utilisez l’option INactif pour 
désactiver le contour de délimitation.

• Nouveau contour : 	 permet de créer un nouveau contour de délimitation rectangulaire, polygonal, ou reprenant 
le tracé d’une polyligne existante.

Ajout de références externes

Modification > Objet > Référence externe > Ajouter, ou 

Permet d’ajouter au dessin des symboles qui dépendent de références externes (blocs, styles de cote, calques, types de 
ligne, styles de texte, etc.).
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Cadre de délimitation des références externes

Modification > Objet > Référence externe > Cadre, ou 

Permet de rendre visible ou invisible les cadres de délimitation des Xref et blocs du dessin.

Gestion des Xrefs

Outils > Options > onglet Fichiers (OP)

Vous pouvez définir dans les options d’AutoCAD des noms de projets, chaque projet pouvant contenir plusieurs 
chemins de recherche. 
Vous pouvez ensuite affecter un projet à chacun de vos dessins (un projet par dessin) à l’aide de la variable 
PROJECTNAME. 
Si AutoCAD ne parvient pas à trouver un fichier lié (Xref ou image), il explorera alors les chemins associés au projet 
affecté au dessin courant.

Droits d’édition des Xrefs

Outils > Options > onglet Ouvrir et enregistrer (OP)

A
B
C

A. Choisissez Activé avec copie pour permettre l’édition par d’autres utilisateurs des Xrefs utilisées dans 
le dessin. Si vous choisissez Activé, les Xrefs seront en lecture seule tant qu’elles seront chargées dans le 
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dessin courant.

B. Détermine si les modifications apportées aux calques de la Xref dans le dessin hôte sont enregistrées 
dans le dessin hôte.

C. Cochez la case pour autoriser l’utilisation de l’Edition de références sur le dessin courant, lorsque celui-
ci est utilisé en tant que Xref dans un autre dessin.

Icônes de notification

Lorsque vous ouvrez un dessin contenant des Xrefs, une icône de notification s’affiche dans la barre d’état, dans 
le coin inférieur droit de l’écran (AutoCAD 2004). Vous pouvez cliquer dessus pour afficher le Gestionnaire des 
références externes.

Si une Xref du dessin est modifiée en-dehors du dessin hôte, une bulle de notification s’affiche pour vous prévenir que 
la Xref doit être rechargée.

 

Edition de références

Principe

Vous avez la possibilité d’éditer un bloc sans avoir à le décomposer, ou d’éditer une Xref du dessin sans avoir à ouvrir 
le fichier externe, en utilisant l’Edition de références.

Dans le cas d’un bloc, les modifications apportées au bloc affecteront toutes les occurrences du bloc dans le dessin.

Dans le cas d’une Xref, les modifications apportées seront enregistrées dans le fichier de la Xref.

Utilisez la barre d’outils Editref :

Editer un bloc ou une Xref

Modification > Editer les Xréfs et les blocs > Edition des références dans le dessin, ou 
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Sélectionner le bloc ou la Xref à modifier, puis cliquez sur OK (l’élément peut être une Xref ou un bloc imbriqué). 
Dans les versions antérieures à AutoCAD 2004, il faut ensuite sélectionner les objets à modifier et valider. 
Le reste du dessin est alors estompé et verrouillé, pour permettre une édition plus facile. L’intensité de l’estompage 
peut être modifiée dans l’onglet Affichage de la boîte de dialogue Options.

 Vous pouvez également double-cliquer sur une Xref ou un bloc (sauf s’il contient des attributs) pour l’éditer.

Ajouter/ supprimer des objets

Modification > Editer les Xréfs et les blocs > Ajouter au jeu de sélection / Supprimer du jeu de sélection, ou  / 

Permet d’importer dans le bloc (ou la Xref) édité des objets du dessin , ou d’en supprimer des objets (ceux-ci 
deviennent alors des entités du dessin).

Enregistrer / ignorer les modifications

Modification > Editer les Xréfs et les blocs > Enregistrer l’édition des références / Fermer les références, ou  / 

Permet de quitter l’édition du bloc (ou de la Xref) en :

• ignorant les modifications apportées durant la session d’édition

•enregistrant les modifications apportées durant la session d’édition : l’objet modifié et reconstruit reste un bloc ou 
une référence externe.

Insertion d’images

Principe

AutoCAD permet d’insérer dans un dessin des images bitmap (raster) dans différents formats courants : JPEG, TIFF, 
PNG, etc. 
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Cela vous permettra d’améliorer la présentation de vos dessins en incluant par exemple des photos issues d’un 
appareil photo numérique ou d’un scanner. Il est également possible d’utiliser une image en fond de plan et de 
dessiner par dessus (dessin hybride raster/vectoriel).

La barre d’outils Référence permet de gérer les images du dessin :

 Les images se comportent exactement de la même manière que les Xrefs : l’emplacement du fichier image est 
mémorisé dans le dessin AutoCAD, et l’image est chargée à l’ouverture du dessin hôte. Si vous transmettez le dessin à 
quelqu’un, le fichier image doit donc être joint au fichier AutoCAD.

Attacher une image

Insertion > Image raster, ou 

Cette commande permet d’insérer une nouvelle image dans le dessin. Après avoir désigné le fichier à insérer, une 
boîte de dialogue apparaît. Elle est quasiment identique à celle permettant l’insertion d’une Xref. 
La taille de l’image dans le dessin est déterminée par la résolution indiquée dans l’image et ses dimensions en pixels, 
par l’unité définie dans la boîte de dialogue Contrôle des unités, et par l’échelle d’insertion de l’image. 

Gestionnaire des images

Insertion > Gestionnaire des images, ou 

Cette commande fait apparaître une boîte de dialogue permettant de gérer les images.

Le bouton Attacher permet d’insérer une nouvelle image dans le dessin. 
En sélectionnant une (ou plusieurs) image, vous pouvez cliquer sur : 
• Détacher : 	 permet de supprimer définitivement une image du dessin 
• Décharger : 	 permet de supprimer temporairement une image du dessin 
• Recharger : 	 fait réapparaître une image déchargée, ou rafraîchit une image modifiée 
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• Parcourir : 	 permet de modifier le chemin de l’image (si le fichier a été déplacé ou renommé par exemple) 
• Enregistrer chemin : 	 permet d’enregistrer définitivement le nouveau chemin de l’image s’il a été modifié.

Délimiter l’image

Modification > Délimiter > Image, ou 

Permet de délimiter l’image sélectionnée à l’aide d’un contour rectangulaire ou polygonal, pour n’en afficher qu’une 
partie.

Options :

• ACtif : 	 affiche uniquement la partie délimitée de l’image

• INactif : 	 affiche toute l’image, en ignorant le contour de délimitation

• Supprimer : 	 supprime un contour de délimitation pour l’image sélectionnée. Pour temporairement désactiver un 
contour de délimitation, utilisez l’option INactif.

• Nouveau contour : 	 permet de créer un nouveau contour de délimitation rectangulaire ou polygonal.

Ajuster l’image

Modification > Objet > Image > Ajuster, ou 

Permet d’ajuster la luminosité, le contraste et l’estompe de l’image sélectionnée. Le réglage de ces valeurs modifie 
l’affichage de l’image, sans modifier le fichier externe.

 Vous pouvez double-cliquer sur le cadre d’une image pour l’ajuster.
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Qualité de l’image

Modification > Objet > Image > Qualité, ou 

Permet de choisir la qualité d’affichage des images (Elevée ou Brouillon). L’affichage en mode Brouillon permet 
d’accélérer les opérations d’affichage (zooms, pan, etc.).

Transparence de l’image

Modification > Objet > Image > Transparence, ou 

Permet d’activer ou désactiver la transparence de l’image sélectionnée. 
Plusieurs formats de fichier image (PNG, TIFF…) acceptent des images comportant des pixels transparents. 
L’activation de la transparence d’une image permet à AutoCAD de reconnaître les pixels transparents afin que le 
dessin s’affiche au travers de ces pixels. Par défaut, les images sont liées avec la transparence désactivée.

Cadre de l’image

Modification > Objet > Image > Cadre, ou 

Permet de rendre visible ou invisible le cadre de délimitation des images du dessin. 
Si le cadre est désactivé, les images ne peuvent plus être sélectionnées.
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DesignCenter et palettes d’outils

DesignCenter

Principe

Le DesignCenter est une palette permettant un accès rapide aux ressources (définitions de calques, blocs, styles de 
texte, styles de cote, styles de tableau, xrefs, présentations…) contenues dans n’importe quel fichier de dessin, qu’il 
soit ou non ouvert dans AutoCAD. 
Vous pouvez importer ces ressources dans votre dessin simplement en les faisant glisser depuis le DesignCenter.

Le DesignCenter

Outils > DesignCenter (CTRL+2), ou  (barre d’outils Standard)

La fenêtre du DesignCenter est divisée en deux : l’arborescence dans la partie gauche et la zone de contenu dans la 
partie droite. 
L’onglet Dossier permet d’accéder dans l’arborescence à tout dessin stocké sur le disque dur ou le réseau. 
L’onglet Dessins ouverts ne donne accès qu’aux fichiers actuellement ouverts dans AutoCAD.

Une fois le fichier source sélectionné dans l’arborescence, double-cliquez dans la zone de contenu sur la catégorie qui 
vous intéresse (calques, blocs, etc.). Vous pourrez ensuite importer un élément dans votre dessin en le faisant glisser 
depuis la zone de contenu du DesignCenter vers la zone graphique de votre dessin.

Vous pouvez également faire glisser un élément depuis le DesignCenter vers une palette d’outils.

clic clic
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Palettes d’outils

Principe

Les palettes d’outils sont affichées sous forme d’onglets dans la Fenêtre des palettes d’outils. 
Elles permettent l’insertion rapide dans le dessin de blocs ou de motifs de hachures principalement, appelés outils. 
Les avantages par rapport à une insertion directe depuis le DesignCenter sont : 
• un accès direct sans avoir à naviguer dans l’arborescence jusqu’au dessin source 
• �la possibilité de personnaliser le comportement des outils (choix du calque sur lequel sera inséré un bloc par 

exemple).

La Fenêtre des palettes d’outils

Outils > Fenêtre des palettes d’outils (CTRL+3), ou  (barre d’outils Standard)

Pour utiliser un outil existant de la palette active, il suffit de cliquer dessus. 
Pour choisir une autre palette, cliquez sur l’onglet correspondant.

Créer une palette

Pour créer une nouvelle palette vide, faites un clic droit sur la palette (pas sur un outil) et choisissez Nouvelle palette 
dans le menu contextuel. 
Vous pouvez de la même manière supprimer ou renommer la palette active.
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Ajouter un outil

Pour ajouter un outil à votre palette, vous pouvez :

• faire glisser dans la palette un bloc, une xref, une image ou un motif de hachures depuis la zone de contenu du 
DesignCenter.

• faire glisser dans la palette un objet du dessin courant, directement depuis la zone graphique. Cet objet peut être 
un bloc, une xref, une image ou un motif de hachures, mais également un objet de dessin (ligne, cercle, etc.) ou une 
cote.

Vous pouvez alors utiliser le nouvel outil pour créer des objets dans votre dessin dont les propriétés seront identiques 
à celles de l’objet que vous avez déplacé vers la palette d’outils.

Modifier un outil

Un clic droit sur un outil vous permettra de le supprimer, de le renommer, ou d’accéder à ses propriétés. 
Les propriétés d’un outil peuvent être personnalisées de manière à prédéfinir les propriétés (calque, couleur, etc.) de 
l’objet qui sera créé par cet outil.
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Mise en page et impression

Mise en page d’un dessin

Une fois votre dessin terminé dans l’onglet objet (sans annotations), il vous faudra passer dans un onglet de 
présentation afin de procéder à sa mise en page et de le configurer pour l’impression.

C’est dans cet onglet de présentation que vous insérerez un cadre et un cartouche, que vous créerez une ou plusieurs 
vues du dessin, et que vous les annoterez.

Les barres d’outils Présentation et Fenêtres vous seront utiles :

 

Configuration du tracé

Fichier > Gestionnaire des mises en page, ou 

Les paramètres de mise en page vous permettent de déterminer l’imprimante à utiliser, le format de papier, 
l’orientation, etc. 
Le Gestionnaire de mises en page permet de : 
• modifier les paramètres de mise en page de l’onglet courant (cliquez sur le bouton Modifier) 
• créer de nouvelles mises en pages nommées (cliquez sur le bouton Nouveau) 
• appliquer une mise en page nommée à la présentation courante (sélectionnez une mise en page et cliquez sur Définir 
courant).
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Une fois ces paramètres définis, vous devriez obtenez une présentation semblable à celle montrée ci-dessous. 
Une fenêtre a été créée, dans laquelle votre dessin apparaît, au moins en partie.

A

B

C

C

A. Fenêtre générée automatiquement. Pour sélectionner la fenêtre, cliquez sur celle-ci. A l’aide des 
poignées vous pourrez la manipuler.

B. Limites de la zone imprimable.

C. Nous sommes en Espace Papier.

Espace Objet et Espace Papier

Dans un onglet de présentation, vous pouvez être dans deux  espaces différents : l’espace PAPIER et l’espace OBJET. 
Cela est indiqué par un bouton de la barre d’état, qui affiche OBJET ou PAPIER. L’icône du SCU s’affiche également 
sous la forme d’une équerre en espace Papier.

En espace Papier, vous ne pouvez travailler que sur la mise en page du dessin, et non sur le dessin lui-même (vous 
pouvez par exemple modifier la fenêtre contenant votre dessin à l’aide de ses poignées, ou insérer un cartouche).

Vous êtes en espace Objet après avoir activé une fenêtre. Vous pouvez alors zoomer à l’intérieur de la fenêtre, et 
dessiner ou modifier des objets exactement comme si vous étiez en onglet Objet. La seule différence est que l’on reste 
dans le contexte d’un onglet de présentation. 
On passe en espace Objet en cliquant sur le bouton PAPIER de la barre d’état. Ce dernier affiche alors OBJET, et une 
des fenêtres s’active (contour gras). Vous pouvez également double-cliquer dans une fenêtre, ou cliquez sur le bouton 
Agrandir la fenêtre  dans la barre d’état (AutoCAD 2005).

On passe à nouveau en espace Papier en cliquant sur le bouton OBJET de la barre d’état. Ce dernier affiche alors 
PAPIER, et les fenêtres se désactivent. Vous pouvez également double-cliquer en-dehors d’une fenêtre. 
Si la fenêtre a été agrandie, cliquez sur le bouton Réduire la fenêtre  dans la barre d’état. 
Vous avez alors la possibilité, en sélectionnant une fenêtre, de la redimensionner à l’aide des poignées.
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Insérer un cadre et un cartouche

Une fois le format de papier fixé, il est temps d’insérer dans le dessin un cadre et un cartouche. Cela se résume en fait 
à l’insertion d’un ou plusieurs blocs, contenant en général des attributs à renseigner (voir chapitre Blocs). 
Ces blocs doivent être insérés en espace Papier à l’échelle 1, de manière à ce que les fenêtres se trouvent à l’intérieur 
du cadre.

 Si le cadre n’est pas centré sur la feuille, modifiez la mise en page. Il suffit de choisir Etendu en aire de tracé, et 
de cocher la case Centrer le tracé. 

 

Gestion des fenêtres

Il est possible de créer plusieurs fenêtres dans un même onglet de présentation, chacune pouvant avoir une échelle 
différente. 
Vous pouvez afficher dans chacune d’elle tout ou une partie seulement de votre dessin (contenu de l’onglet Objet). 
Vous avez également la possibilité de masquer un calque dans une fenêtre en le gardant visible dans une autre (voir 
chapitre Calques).

Utilisez la barre d’outils Fenêtres :

 Il est recommandé de dessiner les fenêtres sur un calque particulier non tracé (voir chapitre Calques), de 
manière à rendre invisible le contour des fenêtres à l’impression.

Définir l’échelle d’une fenêtre

Une fois en espace Objet, il est possible de configurer l’échelle de la fenêtre active. Pour cela, affichez la barre d’outils 
Fenêtres. 
Il suffit de choisir une échelle correcte dans la liste (vous pouvez également y taper une échelle personnalisée sous 
forme de fraction), et d’utiliser le panoramique pour positionner correctement le dessin dans la fenêtre. S’il existe 
plusieurs fenêtres, il suffit de cliquer dans l’une d’elles pour l’activer avant de choisir une échelle.
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 Dans AutoCAD 2006, la liste de facteurs d’échelles peut être personnalisée à l’aide de la boîte de dialogue Format 
> Liste d’échelles.

Verrouiller une fenêtre

Il est également judicieux de verrouiller la fenêtre une fois l’échelle définie. 
Pour cela, sélectionnez la fenêtre (en espace Papier), affichez le menu contextuel (clic droit), et choisissez Verrouiller la 
vue > Actif. 
Une fois cette manipulation effectuée, il n’est plus possible de modifier l’échelle d’une fenêtre. De plus, même en 
espace Objet, vous pouvez zoomer et utiliser le panoramique sans que l’échelle de la fenêtre soit modifiée.

Afficher la boîte de dialogue Fenêtres

Affichage > Fenêtres > Fenêtres existantes, ou 

Cette boîte de dialogue vous permet de créer plusieurs fenêtres simultanément.

Fenêtre unique

Affichage > Fenêtres > 1 Fenêtre, ou 

Permet de créer une nouvelle fenêtre rectangulaire.
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Fenêtre polygonale

Affichage > Fenêtres > Fenêtre polygonale, ou 

Permet de créer une nouvelle fenêtre de forme polygonale.

Convertir un objet en fenêtre

Affichage > Fenêtres > Objet, ou 

Permet de créer une fenêtre à partir d’un objet fermé existant (polyligne fermée, ellipse, spline, région ou cercle).

Délimiter une fenêtre existante

Modification > Délimiter > Fenêtre, ou 

Permet de délimiter une fenêtre rectangulaire existante en utilisant un objet (polyligne fermée, ellipse, spline, région 
ou cercle) dessiné en espace Papier comme contour. 
Vous pouvez également utiliser l’option Polygonal pour tracer un contour de délimitation polygonal.

Gestion des onglets de présentation

Un même fichier peut contenir plusieurs onglets de présentation, ayant chacun ses propres paramètres de tracé. 
Vous pouvez créer un onglet vierge, ou importer un onglet complet depuis un autre dessin, ou un fichier gabarit. 
Vous pouvez également supprimer ou renommer un onglet, ou réorganiser les onglets. 
Tout ceci peut être réalisé à l’aide du menu contextuel obtenu par un clic droit sur un onglet de présentation existant. 
Vous pouvez également utiliser la barre d’outils Présentations.

 

Nouvelle présentation

Outils > Assistants > Créer présentation, ou 

Crée un nouvel onglet de présentation vierge.
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Présentation issue d’un gabarit

Importe une présentation préconfigurée (paramètres de tracé, cadre et cartouche, etc.) depuis un fichier gabarit 
(fichier DWT), ou un fichier dessin (fichier DWG).

Annotations

Cotation

Depuis AutoCAD 2002, vous pouvez créer des cotes complètement associatives, et ce même si vous cotez en espace 
Papier. 
Le plus simple est donc de coter directement en espace Papier toutes les vues, avec une échelle générale des cotes de 
1 (ou Echelle des cotes selon présentation).

 Si vous effectuez un panoramique dans une fenêtre, ou que vous changez son échelle, il vous faudra régénérer les 
cotes (commande COTREGEN, voir chapitre Cotation), afin qu’elles se repositionnent correctement par rapport à la 
géométrie cotée.

Pour conserver une compatibilité maximale de vos fichiers avec les versions antérieures d’AutoCAD, vous pouvez 
également coter en espace Objet dans l’onglet de présentation. Il faut alors absolument verrouiller les fenêtres, et 
cocher la case Echelle des cotes selon présentation pour le style de cote utilisé (Format > Style de cote > bouton Modifier 
> onglet Ajuster).

Texte

Vous pouvez créer du texte en espace Papier ou en espace Objet, suivant le cas :

• en espace Papier, vous pouvez créer du texte de mise en page (légende, identifiant de détail). Vous donnerez à ce 
texte la hauteur qu’il doit avoir sur le plan papier.

• en espace Objet, vous pouvez créer du texte en rapport direct avec une partie du dessin. Il faudra alors compenser 
l’échelle de la fenêtre (par exemple pour créer du texte de hauteur 5 mm sur le papier dans une fenêtre au 1/50, il 
faudra lui donner une hauteur de 250 unités).
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Impression

Aperçu avant impression

Fichier > Aperçu du tracé (AP), ou  (barre d’outils Standard)

Cette commande montre l’apparence qu’aura le dessin une fois tracé. L’aperçu est basé sur la configuration courante 
du tracé définie à l’aide de la commande Mise en page. Le style de tracé et les épaisseurs apparaissent à l’aperçu, et 
vous pouvez zoomer durant l’aperçu. 
Utilisez le menu contextuel ou la barre d’outils du mode d’aperçu pour quitter ou tracer depuis l’aperçu.

Imprimer

Fichier > Imprimer (TC ou CTRL+P), ou 

Cette commande affiche une boîte de dialogue semblable à la boîte de dialogue Mise en page, mais le tracé est 
déclenché lorsque vous cliquez sur OK. 

Cliquez sur le bouton  pour accéder à tous les paramètres d’impression.




